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MADRIX 3 Script Help and Manual Version 2.15. [Part A] What is New

1 What is New

Overview

The current MADRIX Script version is 2.15.
There are a lot of new features within MADRIX and therefore also in MADRIX Script.

News For Script Engine Version 2.15 (MADRIX 3.5)

New General Functions:

= »SetChromakKey

News For Script Engine Version 2.14 (MADRIX 3.4)

New General Functions:

= »SetDmxFaderValue

= »GetDefaultShape

= »RenderShape

New General Structure:

= »shape

New Functions For The Main Output Macro:

= »CueSetGroupPreset
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= »CueGetGroupPreset

= »GetGroupCount

= »GetGroupldByIndex

= »GetGroupDefaultValue

= »GetGroupDefaultValueBylndex
= »GetGroupDisplayColor

= »GetGroupDisplayColorByIndex
= »GetGroupDisplayName

= »GetGroupDisplayNameByIndex
= »SetGroupValue

= »SetGroupValueByIndex

= »GetGroupValue

= »GetGroupValueByIndex

= »SetGroupFlashMode

= »SetGroupFlashModeByIndex
= »GetGroupFlashMode

= »GetGroupFlashModeByIndex
= »ToggleGroupFlashMode

- »ToggleGroupFlashModeByIndex
= »SetGroupFadeTime

= »GetGroupFadeTime

= »SetGroupPreset

= »CallGroupPreset

New Filters / Effects (FX):

= »FILTER _KALFIDOSCOPE_6x

www.madrix.com 17
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= »FILTER_KALFIDOSCOPE_8x

= »FILTER KALEIDOSCOPE 12x

New Functions And Constants For MADRIX Effects:

= »ChaserCallCurrentStep

= »ChaserCallNextStep

= »ChaserCallPreviousStep

= »ChaserGetCurrentStep

= »ChaserGetStepCount

= »ChaserGetLoopCount

= »ChaserGetlLoopProgress

= »ChaserGetlLoopTime

= »ChaserGetPlaybackState

= »ChaserGetStepDescription

= »ChaserGetStepFadeTime

= »ChaserGetStepFadeType

= »ChaserGetStepProgress
= »ChaserGetStepTime

= »ChaserGetStepWaitTime

= »Chaserlnvert

= »ChaserMoveStepDown

= »ChaserMoveStepUp

= »ChaserPause

= »ChaserPlay

= »ChaserSetloopCount
= »ChaserSetNextStep

= »ChaserSetPreviousStep

= »ChaserSetStepDescription

= »ChaserSetStepFadeTime
= »ChaserSetStepFadeType
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= »ChaserSetStepWaitTime
= »ChaserStop

= »ChaserSwapSteps

= »PLAYBACK FADING

= »PLAYBACK PAUSED

= »PLAYBACK PLAYING

= »PLAYBACK_STOPPED

New Functions And Constants For MADRIX Effects that use Shapes:

= »SetRenderingMode

= »GetRenderingMode

= »SetShapeRotation

= »GetShapeRotation

= »SetShapeOrigin

= »GetShapeOrigin

= »RENDERING_MODE_SIMPLE

= »RENDERING MODE EXTENDED

= »RENDERING MODE_BLOBBY

= »SHAPE TYPE HEART OUTLINED

= »SHAPE_TYPE HEART_OUTLINED_IMPLODE

= »SHAPE TYPE HEART OUTLINED EXPLODE

= »SHAPE_TYPE_HEART_FILIED

= »SHAPE TYPE HEART FILLED IMPLODE

= »SHAPE_TYPE HEART FILIED EXPLODE

= »SHAPE TYPE CROSS OUTLINED

www.madrix.com 119
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= »SHAPE

= »SHAPE

TYPE

TYPE

CROSS_OUTLINED IMPLODE

CROSS OUTLINED EXPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

CROSS_FILLED

CROSS FILLED IMPLODE

= »SHAPE

= »SHAPE

TYPE

TYPE

CROSS_FILLED EXPLODE

CROSS_STRAIGHT OUTLINED

= »SHAPE

" »S HAPE

TYPE

TYPE

CROSS_STRAIGHT OUTLINED_IMPLODE

CROSS_STRAIGHT OUTLINED EXPLODE

= »SHAPE

= »SHAPE

TYPE

TYPE

CROSS_STRAIGHT _FILLED

CROSS STRAIGHT FILLED IMPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

CROSS_STRAIGHT FILLED EXPLODE

STAR OUTLINED

= »SHAPE

= »SHAPE

TYPE

TYPE

STAR_OUTLINED IMPLODE

STAR_OUTLINED EXPLODE

= »SHAPE

" »S HAPE

TYPE

TYPE

STAR_FILLED

STAR FILLED IMPLODE

= »SHAPE

= »SHAPE

TYPE

TYPE

STAR_FILLED EXPLODE

TRIANGLE OUTLINED

" »S HAPE

TYPE_TRIANGLE_OUTLINED IMPLODE

= »SHAPE

TYPE TRIANGLE OUTLINED EXPLODE

= »SHAPE

TYPE TRIANGLE FILLED

= »SHAPE

TYPE TRIANGLE FILLED IMPLODE

= »SHAPE

TYPE TRIANGLE FILLED EXPLODE

" »S HAPE

TYPE 3D HEART UNFILLED

= »SHAPE

TYPE_3D_HEART_UNFILLED IMPLODE

= »SHAPE

TYPE 3D HEART UNFILLED EXPLODE

" »S HAPE

TYPE_3D_HEART FILLED

= »SHAPE

TYPE 3D HEART FILLED IMPLODE

= »SHAPE

TYPE 3D HEART FILLED EXPLODE

= »SHAPE

TYPE 3D STAR UNFILLED

= »SHAPE

TYPE_3D_STAR_UNFILLED IMPLODE
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= »SHAPE

= »SHAPE

TYPE

TYPE

3D_STAR_UNFILLED EXPLODE

3D STAR FILLED

" »S HAPE

= »SHAPE

TYPE

TYPE

3D_STAR_FILLED IMPLODE

3D STAR FILLED EXPLODE

= »SHAPE
= »SHAPE
= »SHAPE

" »S HAPE

TYPE

TYPE

TYPE

TYPE

3D_CROSS
3D_CROSS
3D_CROSS
3D_CROSS

UNFILLED
UNFILLED IMPLODE
UNFILLED EXPLODE

FILLED

= »SHAPE

= »SHAPE

TYPE

TYPE

3D_CROSS
3D_CROSS

FILLED IMPLODE

FILLED EXPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

3D_CROSS
3D_CROSS

STRAIGHT UNFILLED

STRAIGHT UNFILLED IMPLODE

= »SHAPE
= »SHAPE
= »SHAPE

" »S HAPE

TYPE

TYPE

TYPE

TYPE

3D_CROSS
3D_CROSS
3D_CROSS
3D_CROSS

STRAIGHT UNFILLED EXPLODE

STRAIGHT FILLED

STRAIGHT FIILED IMPLODE

STRAIGHT FILLED EXPLODE

= »SHAPE

= »SHAPE

TYPE

TYPE

PYRAMID_UNFILLED

PYRAMID UNFILLED IMPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

PYRAMID_UNFILLED EXPLODE

PYRAMID FILLED

= »SHAPE
= »SHAPE

= »SHAPE

TYPE

TYPE

TYPE

PYRAMID FILLED IMPLODE

PYRAMID FILLED EXPLODE

RANDOM_STATIC

" »S HAPE

TYPE

RANDOM _IMPLODE

= »SHAPE

= »SHAPE

TYPE

TYPE

RANDOM_EXPLODE

RANDOM_OUTLINED

" »S HAPE

= »SHAPE

TYPE

TYPE

RANDOM_OUTLINED_STATIC

RANDOM OUTLINED IMPLODE

= »SHAPE
= »SHAPE

= »SHAPE

TYPE

TYPE

TYPE

RANDOM_OUTLINED EXPLODE

RANDOM _UNFILLED

RANDOM_UNFILLED STATIC

www.madrix.com

1111



MADRIX 3 Script Help and Manual Version 2.15.

[Part A] What is New

= »SHAPE

= »SHAPE

TYPE

TYPE

RANDOM_UNFILLED IMPLODE

RANDOM UNFILLED EXPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

RANDOM_FILLED

RANDOM FILLED STATIC

= »SHAPE
= »SHAPE
= »SHAPE

" »S HAPE

TYPE

TYPE

TYPE

TYPE

RANDOM_FILLED_IMPLODE

RANDOM FILLED EXPLODE

2D

2D

RANDOM

RANDOM

STATIC

= »SHAPE

= »SHAPE

TYPE

TYPE

2D

2D

RANDOM

RANDOM

IMPLODE

EXPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

2D

2D

RANDOM
RANDOM

OUTLINED

OUTLINED STATIC

= »SHAPE

= »SHAPE

TYPE

TYPE

2D

2D

RANDOM

RANDOM

OUTLINED IMPLODE

OUTLINED EXPLODE

= »SHAPE

" »S HAPE

TYPE

TYPE

2D

2D

RANDOM

RANDOM

FILLED

FILLED STATIC

= »SHAPE

= »SHAPE

TYPE

TYPE

2D

2D

RANDOM

RANDOM

FILLED IMPLODE

FILLED EXPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

3D

3D

RANDOM
RANDOM

STATIC

= »SHAPE

= »SHAPE

TYPE

TYPE

3D

3D

RANDOM

RANDOM

IMPLODE

EXPLODE

= »SHAPE

" »S HAPE

TYPE

TYPE

3D

3D

RANDOM

RANDOM

UNFILLED

UNFILLED STATIC

= »SHAPE

= »SHAPE

TYPE

TYPE

3D

3D

RANDOM

RANDOM

UNFILLED IMPLODE

UNFILLED EXPLODE

" »S HAPE

= »SHAPE

TYPE

TYPE

3D

3D

RANDOM
RANDOM

FILLED

FILLED STATIC

= »SHAPE

= »SHAPE

TYPE

TYPE

3D

3D

RANDOM

RANDOM

FILLED IMPLODE

FILLED EXPLODE
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= »ORIGIN

CENTER

= »0RIGIN

FRONT

= »0RIGIN

BACK

= »ORIGIN

LEFT

= »ORIGIN

RIGHT

TOP

= »0RIGIN

= »0RIGIN

BOTTOM

= »ORIGIN

TOP_LEFT

= »ORIGIN

TOP_RIGHT

= »0RIGIN

BOTTOM_LEFT

= »0RIGIN

BOTTOM_RIGHT

= »ORIGIN

FRONT LEFT

= »ORIGIN

FRONT_RIGHT

= »0ORIGIN

BACK_LEFT

= »0RIGIN

BACK_RIGHT

= »ORIGIN

FRONT_TOP

= »ORIGIN

FRONT_BOTTOM

= »0ORIGIN

BACK _TOP

= »0RIGIN

BACK_BOTTOM

= »ORIGIN

FRONT _TOP_LEFT

= »ORIGIN

FRONT_TOP_RIGHT

= »0ORIGIN

FRONT_BOTTOM_LEFT

= »0RIGIN

FRONT_BOTTOM_RIGHT

= »ORIGIN

BACK TOP_LEFT

= »ORIGIN

BACK_TOP_RIGHT
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= »0ORIGIN_BACK BOTTOM_LEFT

= »0ORIGIN BACK BOTTOM_RIGHT

New Functions For SCE Bounce:

= »SetBorder

= »GetBorder

= »SetPixelBorder

= »GetPixelBorder

= »SetOuterGlow

= »GetOuterGlow

= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetlnnerGlow
= »GetInnerGlow
= »SetPixellnnerGlow

= »GetPixellnnerGlow

New Functions For SCE Explosions:

= »SetOuterGlow
= »GetOuterGlow
= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetlnnerGlow
= »GetInnerGlow
= »SetPixellnnerGlow

= »GetPixellnnerGlow
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New Functions For SCE Fill Drops:

»SetBorder

= »GetBorder

= »SetPixelBorder

= »GetPixelBorder

= »SetOuterGlow

= »GetOuterGlow

= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetlnnerGlow
= »GetlnnerGlow
= »SetPixellnnerGlow

= »GetPixelInnerGlow

New Functions For SCE Fill Random:

= »SetBorder

= »GetBorder

= »SetPixelBorder

= »GetPixelBorder

= »SetOuterGlow

= »GetOuterGlow

= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetlnnerGlow
= »GetInnerGlow
= »SetPixellnnerGlow

= »GetPixellnnerGlow
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New Functions For SCE Fill Snake:

»SetBorder

= »GetBorder

= »SetPixelBorder

= »GetPixelBorder

= »SetOuterGlow

= »GetOuterGlow

= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetlnnerGlow
= »GetlnnerGlow
= »SetPixellnnerGlow

= »GetPixelInnerGlow

New Functions For SCE Noise:

= »SetBorder

= »GetBorder

= »SetPixelBorder

= »GetPixelBorder

= »SetOuterGlow

= »GetOuterGlow

= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetlnnerGlow
= »GetInnerGlow
= »SetPixellnnerGlow

= »GetPixellnnerGlow
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New Functions For SCE Shapes:

= »SetOuterGlow
= »GetOuterGlow
= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetInnerGlow
= »GetInnerGlow
= »SetPixellnnerGlow

= »GetPixellnnerGlow

New Functions For SCE Simple Shape:

= »SetOuterGlow
= »GetOuterGlow
= »SetPixelOuterGlow

= »GetPixelOuterGlow

= »SetOuterGlowInterpolationType

= »GetOuterGlowInterpolationType

= »SetlnnerGlow
= »GetInnerGlow
= »SetPixellnnerGlow

= »GetPixelInnerGlow

= »SetlnnerGlowInterpolationType

= »GetInnerGlowInterpolationType

= »SetProportion
= »GetProportion
= »SetDiagonals
= »GetDiagonals
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New Functions For SCE Swarm:

»
»
»
»
»
»
»

»

New Functions For M2L Drops:

»
»
»

»

New Functions For M2L Tubes:

»
»
»

»

New Functions For M2L Single Tone Spectrum:

»
»

»
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= »GetToneRangeMax

New Functions For M2L Shapes:

= »SetToneRangeMin

= »GetToneRangeMin

= »SetToneRangeMax

= »GetToneRangeMax

News For Script Engine Version 2.11 (MADRIX 3.3)

New Effects:

= »SCE Clouds

= »SCE Noise

New Functions For SCE Counter:

= »SetExtrusion
= »GetExtrusion
= »SetPixelExtrusion

= »GetPixelExtrusion

New General Functions:

= »WriteTextClear

= »GetTimeSunrise

= »GetTimeSunriseCity

= »GetTimeSunset
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= »GetTimeSunsetCity

New Functions For Storage Place Macro:

= »SetSpeedPitch

= »GetSpeedPitch

New Functions For The Main Output Macro:

= »SetFilterColor
= »GetFilterColor

= »CuelistCurrentCue

= »CuelistCount

= »CuelistCueAllOccupied

= »CuelistNew

= »CuelistProgress
= »CueAdd

= »CueDelete

= »CueDeleteAll

= »CueDeleteCurrent

= »CueSetDescription

= »CueGetDescription

= »CueSetDate

= »CueGetDateYear
= »CueGetDateMonth
= »CueGetDateDay

= »CueSetDateWeekday
= »CueGetDateWeekday

= »CueSetDateString
= »CueGetDateString

= »CueSetTimeCode
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= »CueGetTimeCodeHour

= »CueGetTimeCodeMinute

= »CueGetTimeCodeSecond

= »CueGetTimeCodeFrame

= »CueSetTimeCodeString

= »CueGetTimeCodeString

= »CueSetDuration

= »CueGetDurationHour

= »CueGetDurationMinute

= »CueGetDurationSecond

= »CueGetDurationFrame

= »CueSetDurationString

= »CueGetDurationString

= »CueSetFollow

= »CueGetFollowCue

= »CueSetStorage
= »CueGetStorage

= »CueSetPlace
= »CueGetPlace

= »CueSetFadeType

= »CueGetFadeType

= »CueGetFadeTypeString

= »CueSetFadeTime

= »CueGetFadeTime

= »CueGetFadeTimeString

= »CueSetFadeColor

= »CueGetFadeColor
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Deprecated Functions:

= Several functions have been renamed. Corresponding, previous functions have been deprecated. More

information is provided throughout this user guide when applicable.

News For Script Engine Version 2.7 (MADRIX 3.2)

New Effects:

»
»

»

New Functions And Constants For SCE Metaballs:

»
»
»
»
»

»

»

»

New Functions For Color Table:

»
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= »ColorTablelnvert

New Functions For Image Table:

= »ImagelListinvert

News For Script Engine Version 2.3 (MADRIX 3.1)

New GUI Elements for MAS Script:

= »ctrlbutton5
= »ctrlbutton6
= »ctrledits

= »Cirledit6

New Effect:
= »SCE Fill Drops
New Effect:

= »SCE Fill Snake

New Effect:

= »SCE Fill Solid

New Effect:

= »SCE Swarm

New Effect:

= »S2L Level Color Scroll

New Effect:

= »S2L Level Shape
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New Effect:

»

New Functions For SCE Simple Shape:

»
»
»

»

New Functions For M2L Color Table:

»
»

»

New Functions And Constants For SCE Capture:

»

»

»

»

New Functions And Constants For SCE Image:

»

»

»

»
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New Functions And Constants For SCE Ticker / Scrolling Text:

»

»

»

»

New Functions And Constants For SCE Video

»

»

»

»

News For Script Engine Version 2.1 (MADRIX 3.0)

= MADRIX 3.0 includes a large number of (technical) improvements. That is why large parts of MADRIX Script 2.1

were updated as well.
= Throughout the Script documentation you will find a lot of updates and changes.

= Previous macros and scripts written for MADRIX 2.X might not work anymore for MADRIX 3.X. Please use the

provided migration hints to update your scripts and macros!

= Migration hints are provided in the corresponding topics.
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2 MADRIX Script (Introduction)

2.1 Basics
2.1.1 Getting Started

Introduction

= MADRIX Script is the scripting language of MADRIX. It is built into MADRIX.

= This document is for all those who want to develop and modify light effects with the help of MADRIX Script. This

does not require any programming knowledge although such knowledge can be helpful.

Examples

With MADRIX Script you could do the following, for example:

» Displaying the current time using SCE Ticker / Scrolling Text.
» Increasing and decreasing the size of shapes according to the audio input level.
= Automatically activating or deactivating a Blackout at certain times.

» Setting different Layer filters for different Layers according to automatic parameters.
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Overview

4 Locations
There are 4 possibilities to use MADRIX Script.

= MAS Script Effect
The first option to create a new effect from scratch.

Learn more »

» Macros for Effects
The second option involves modifying the settings of an MADRIX Effect. This includes all SCE, S2L, M2L, and
MAS effects.

Learn more »

= Storage Place Macro
Fourth, you can use Storage Place macros to influence every single Storage Place individually.

Learn more »

= Main Output Macro
The third possibility controls the Main Output directly.

Learn more »

MAS Script Effect — Create Your Own Effects

MADRIX offers endless possibilities to create a light show. However, there are a lot more things that you are maybe
not able to do with the current stock effects. The script effect, called MAS Script Effect provides the possibility to

program your own, original effects.

Macros For Effects — Control Running Effects
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Macros are also written in MADRIX Script, but are part of an effect. With macros it is possible to control effects (or
Layers) and change their outcome. For example, render parts of an effect transparent or change the color with a gray

filter.

Main Output Macro — Control Your Final Output

Whereas the MAS Script Effect is an individual effect in itself and while macros can be used to manipulate single
effects or Layers, the Main Output Macro affects the final output of MADRIX towards your LEDs.

Storage Place Macro — Control Individual Storage Place Including All Layers

The Storage Place Macro allows you to use a macro that affects your individual Storage Place including all of its

Layers.
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2.1.2 The Script/Macro Editor

Introduction

The Script/Macro Editor is the tool to control and manage macros and scripts.

File Edit View Script Help

De @ & BB @ m

1 @scriptname="";
2 @anthor="";
32 @version="";
4 Bdescription="";
5
8 vold InitEffect|()
T{
8
91
10
11 void RenderEffect()
12 {
13
14 :
15
18 vold MatrixSizeChanged ()
17 {
18 InitEffect():
s

Script Output

Compiler Messages

Helle World
Helle World
Helle Waorld
Helle World
Helle Waorld
Helle Waorld
Helle World
Helle Waorld
Helle World
Helle Waorld
Helle Waorld

» Menu - Includes several submenus to perform various actions of the Script/Macro Editor.

» Toolbar - Includes various shortcuts to quickly execute the most common actions, such as Save, Load, or

Compile.

» Text Field - The text field to enter source code and functions takes up the largest part of the Script/Macro

Editor.
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= Script Output - Provides a display to put out messages from the script itself.
- Go to Edit > Clear Script Outputor Edit > Clear Script Output / Compiler Messages to delete messages

that are not needed anymore.

» Compiler Messages - Provides information of the Script/Macro Editor and displays errors or other messages.
- Go to Edit > Clear Compiler Messages or Edit > Clear Script Output / Compiler Messages to delete

messages that are not needed anymore.

Overview

Creating, Loading, and Saving Scripts
» Go to File > New to create a new template, which is the basis of a new script or macro. Or use the toolbar
shortcut.
= Go to File > Open... to load an existing script or macro from an external file. Or use the toolbar shortcut.

= Go to File > Save or File > Save As... to store a script or macro on your harddisk or any other storage medium.

Or use the toolbar shortcut.

= Go to File > Close to close the Script/Macro Editor. Or use the window shortcut.

Compiling and Executing Scripts

Before a script or macro can run, it needs to be compiled. While compiling the script, it is analyzed and translated into
the format MADRIX understands internally.

» Go to Script > Compile to compile the current source code. Or use the toolbar shortcut. After the script was
compiled successfully, it will be executed automatically. If the compilation fails, the script cannot be executed. An
error message will be displayed. Just double-click on the message and the cursor will jump to the referred

position. In addition, the line number is printed with each compiler message.
= Go to Script > Compile And Save... to create a crypted, secured macro or script. Or use the toolbar shortcut.

= Go to Script > Start Script to start a script or macro once it has been compiled and stopped again. Or use the

toolbar shortcut.

» Go to Script > Stop Script to halt the execution of a script. Or use the toolbar shortcut.
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File Types

*.mas MADRIX Script File
A script for the MAS Script Effect.

*.macs Encrypted MADRIX Script File

A compiled and encrypted script for the MAS Script Effect. This is a script which does not contain
any source code, but only the runtime code. This means that with the help of compiled scripts it is
possible to share scripts, but to let the source code remain a secret at the same time. Because a

compiled script does not contain any source code, only the script's meta data will be displayed in

the window when you load such a kind of file. You (or others) will not be able to edit the code.

*.mms MADRIX Effect Macro
A Macro for an effect, a Storage Place Macro, or a Main Output Macro.

*.mcm MADRIX Crypted Effect Macro

A compiled and encrypted Macro for an effect, a Storage Place Macro, or a Main Output Macro.
This is @ macro which does not contain any source code, but only the runtime code. This means
that with the help of compiled macros it is possible to share macros, but to let the source code

remain a secret at the same time. Because a compiled script does not contain any source code,

only the script's meta data will be displayed in the window when you load such a kind of file. You

(or others) will not be able to edit the code.

2.1.3 Writing A Script

Introduction

» In general, a script or macro consists of many instructions, which you enter in the corresponding Script/Macro

editor.

= The result is called source code, macro, or script.
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The First Example

= A first example of a MADRIX Script can be seen below for the MAS Script Effect.
= You can simply copy and paste the source code and execute it.

» The example repeatedly writes a certain text line in the Script Output of the editor.

1) Please open the Script Editor of the MAS Script Effect. Simply copy the whole example into the Editor (and replace
the existing code):

@cri pt nane="",

@ut hor="";

@ersion="";
@escription="";

void InitEffect()

{

}

voi d RenderEffect()

{ WiteText("Hello World");
}

voi d Matri xSi zeChanged()
{InitEffect();

}

2) Compile the script (go to Script > Com pile).

3) The function WriteText(string text) writes a given character string into the Script Output of the Script Editor. In this

case it is "Hello World".

4) You should see this message in the Script Output.
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2.1.4 Syntax Highlighting

Overview

File Edit View Script Help

O E + B2 M@ 0 Ed» B 7

1 @scriptname="";
2 Bauthor="";
32 Bversion="";
4 Bdescription="";
5
6 void InitEffect()
T {
8
=
10
11 void RenderEffect|)
12 {
13
s 1
15
16 wvoid MatrixS5izeChanged ()
17 {
18 InitEffect():
s

Script Output Compiler Messages

Helle Waorld
Helle Waorld
Helle World
Helle Waorld
Helle World
Helle World
Helle Waorld
Helle World
Helle Waorld
Helle World
Helle World

= The Script/Macro Editor supports syntax highlighting: as you can see from the screenshot above, MADRIX Script
highlights code according to a color scheme.

= Highlighting will help you to read the source code, to distinguish different types of phrases (e.g., comments, data

types, etc.), to quickly recognize functions, and to find errors.

» In addition, code structuring is enhanced since every line is automatically indented like the last line.
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@cri pt nane, Represents functions that can only be used in certain areas of MADRIX Script (for
SetFilter example, Storage Place Macro).
voi d Represents data types.

FI LTER BLUR Represents global variables and constants.

Filter, WiteText Represents functions that can be used in all areas of MADRIX Script (MAS Script Effect,

Macros for Effects, Storage Place Macro, Main Output Macro)

"Hell o Worl d" Represents written text for output.

2.1.5 Identifiers

Identifiers are the names of functions or variables.

They start with a letter or an underline (_). Other letters, underlines, or numbers can follow afterwards.
The exception to this are all characters that do not belong to the English alphabet, e.g. '@’ or 'é'.

There is no restriction for the length of an identifier.

Furthermore, there is a distinction between capitalized letters and the use of small letters. For example, Name

and name are two different identifiers.

Examples for valid identifiers: textFunc, _testVar2, new, NEW, New_12340

Examples for invalid identifiers: 12help, 1234, grdsser, straBe
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2.1.6 Functions

Working With Functions

= A script/macro in MADRIX Script consists of a set of functions.

» Some of these functions are required and called by MADRIX.

Others may be used to split the script into smaller parts.

Functions form small parts of a script and hold a humber of statements.

They can be called from other parts of the script in order to execute their statements.

Having statements used outside of functions is not allowed in MADRIX Script.

Creating Functions

Functions consist of a head and a body. The head describes the name of the function, its parameters, and its return

value. Whereas, the body includes a block of statements, like this one:

void function(int p)

{
if(p*p>2)
do sonet hi ng;
do sonet hi ng nore;
}

The first data type, stated in front of the function, describes the kind of value the function returns and it may be of any
known data type. In the case above, no value is returned by the function and therefore void is declared. The actual
name of the function can be any name that follows the rules of identifiers in MADRIX Script as was discussed above.
But it has to be unique. It is not allowed to have several functions with the same name or with the name of global

variables or constants.

The parameter list following the name of the function may be left empty, but it is necessary to keep the brackets ().
Different parameters are separated by comma. A parameter can take on any data type possible. Here are three

examples for function declarations:

voi d setPixel (int point[])

{
}

do sonet hi ng

int[] GeatePoint(int x, int vy)
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do sonet hi ng

string getTag()
{

}

do sonet hi ng

Passing Parameters In MADRIX Script

Parameter are always passed via copy by value (The exception are » ). This means that a parameter may be
used as another local variable of a function. Changing the value of a variable does not change the variable the caller
has provided.

Note: A reference is created for arrays. Hence, changing an array results also in changing the array of the caller.

void testFunc(int i, int ia[])
{

i =5

for(int n =0; n <i; n++)

{

ia[n] = n* n;

}

}

voi d RenderEffect()

{

int testArray[];

int len = 2;

test Func(len, testArray);
}
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In testFunc the parameter iis set to 5 and the array that is passed is filled with several values. After the return of the
function in RenderEffect, the array is now filled with the values set in testFunc. Whereas the variable len has not

changed and still has a value of 2.

Note: Passed parameters are always copied to a function, while this is not the case with arrays.

Returning A Value

To return a value, the return statement must be used followed by an expression. The given expression must result in
the same or at least a compatible data type of the declared function's type. It must be the last statement of any
function which returns a value unequal to void. In addition, return can be used to leave a function early. For void
functions return will be used without an expression. Here are some examples:

int[] GeatePoint(int x, int vy)

{
int res[] = {x, y};
return(res);

string getTag()

{
date d = GetDate();
swi t ch(d. weekday)
{
case 0: return("Sunday"); break;
case 1. return("Mnday"); break;
case 2: return("Tuesday"); break;
case 3: return("Wednesday"); break;
case 4: return("Thursday"); break;
case 5 return("Friday"); break;
case 6: return("Saturday"); break;
}
ret urn("unknown day");
}

Functions Called By MADRIX

= Each macro or script includes a number of predefined functions called by MADRIX.

» If @ function is not needed by a script, it is not necessary to implement it. A message is printed out if one of

them is missing. This is not an error, but only an information for the developer of the script.
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» Please note that each component of the MADRIX Script language (MAS Script Effect, Macros, Main Output
Macro, Storage Place Macro) may include a different combination of these five functions as this is just an

overview:

void InitEffect()

voi d RenderEffect ()

voi d PreRender Ef fect ()
voi d Post Render Ef fect ()

void Matri xSi zeChanged()

* More information is available in the corresponding chapters.
Learn more »
Learn more »
Learn more »

Learn more »

Further Information

» There are a lot of functions which can be used in MADRIX Script for different functionality (e.g., to draw objects

the matrix, get the data of the sound analysis, or mathematical functions).

= Learn more »

2.1.7 Data Types And Variables
= In MADRIX Script variables may be used to store different data.

» Each variable will be defined with a certain data type.

= This data type describes the kind of values the variable can store and the operations which are possible with the

variable.

Here is a small example to get a feeling for variables. The following source code renders a yellow pixel on a random
position each time RenderEffectis called.
@cri pt nane=" Set RandonPi xel ";

@ut hor ="i noage";
@ersion="";
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@escription="";

void InitEffect()

{
}
voi d RenderEffect()
{
color col = {255, 255, 0, 0};
int px,py;
px = random(0, Get Matri xWdth()-1);
py = random( 0, Get Matri xHei ght ()-1);
Set Pi xel (col, px, py);
/la color variable called 'col' is declared and its values are set to yell ow (RGB)

//two variables of type int are declared to store the coordinates of a pixel
/lcoordinates for x and y inside the matrix are chosen by chance
//the pixel is drawn on the matrix

}
voi d Matri xSi zeChanged()
{
InitEffect();
}

2.1.7.1 Using Variables

Introduction

In order to use a variable it must be declared first. This is done by stating the data type of the variable and a name,
followed by a semicolon. Furthermore, it is possible to initialize them during the declaration using an equal sign. This
means that a particular value can be assigned to the variable already during initialization. Here are some examples:

int i;
float f;
int kK = 4;

string text = "Hello Wrld";
int width = GetMatri xWdth();

A structure is initialized with a list of expressions separated by comma and written in curly brackets.

color white = {255, 255, 255, 255, 0};
color red = {255};
date d = {24, 11, 1980};
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If not all elements of a structure are initialized, the rest will be set to 0.

Constants

It is also possible to declare a variable as a constant. Those variables cannot be changed while the script is running
and must be initialized during their declaration. They may be used to simplify the reading of the script code. For

example, there is a global constant called PI To declare a variable as a constant use the keyword const

const int width = 10;
const int maxPixel = 20 * w dth;

Global And Local Variables

A variable exists within the block in which it has been defined. This may be a function or a block like it is described in
statements. It does not exist outside this area. A variable i, which was defined in the function RenderEffect, does not
exist in any other function. Whenever such a block is entered, due to a function call, a loop or something different, the

variable is re-initialized. Because of that, a local variable loses its assigned value between two calls of the function.

Global variables on the other hand are available within the whole script, beginning with when they are defined. They
can be used to hold data during the run of a script. Global variables do also exist between two calls of RenderEffect. If
the script needs to hold data between to runs, global variables are the correct way to do this.

int g_iPos = 0;

voi d Render Effect ()

{
Set Pi xel (WH TE, g_i Pos, 0);
g_iPos = (g_iPos + 1) % GetMatrixWdth();

g_iPos is increased by 1 each time the script is called. It is used to determine the new position of a pixel set to white.

void InitEffect()
{

}

g_i Pos 0;

int g_iPos = 0;

voi d Render Ef fect ()
{
Set Pi xel (WH TE, g_i Pos, 0);
g_iPos = (g_iPos + 1) % GetMatrixWdth();
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This script will fail since g_iPos is unknown in function InitEffect. It has been declared after this function. In this way,

only RenderEffect can use it.

Saving Data

Effects in MADRIX can be stored in a single file or in a whole MADRIX Setup file. Furthermore, it is possible to change
a Storage Place to show another effect. If a script effect is reloaded with a compiled and running script, InitEffectis
called and the script starts from the beginning. Sometimes it is useful that a script does not start from its beginning
(for example, a black matrix) but from the same state where it was when it has been stored or the Storage Place has

been changed.

The values of global variables do not only remain between two calls of a script, but may be stored when the effect is

saved, too. Therefore, the variable should be declared as persistent.

persistent int g_iPos;

Whenever the script is saved, the content of g_iPos is also saved. It is loaded again, when the script is loaded. This
loading procedure is executed after InitEffect has been called. Even if the variable is originally initialized in InitEffect,

it will contain the saved data after InitEffect has been called, nevertheless.

More Information

In MADRIX Script several constants are defined by default. They may be used to make the source code more legible.

The summary contains an »
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2.1.7.2 Using Data Types

Primitive Data Types

Overview

Variables offer the possibility to store data. The kind of data depends on the data type. MADRIX Script supports the
following primitive data types:

Data Type Sample Values Description
int 3, -345, 234, 0 32 bit data type. It stores integral numbers between -2 milion and +2 milion.
float 0.0, -12.45, 3.1415 32 bit data type. It stores floating point numbers.
string "Hello World", "-3" Stores character strings of variable length.
bool true (1), false (0) Used for implicit use of logical values and comparisons.

Data Type Bool

The data type boolis only used internally and cannot be used to declare a variable. This data type only has to possible
values, true or false. It is used for logical operations or for different statements like the » . For example,

the following expression results in a bool data type and false as its value.

3>14
int i =3 >4 //results inO
int i =3<4//resultsinl

/lusually it is used like this
if(3 > 4)
{

}

do sonet hi ng
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True And False
As stated above, a boolean expression results only in true or false.

Furthermore, the keywords TRUE and FALSE are used within MADRIX Script as function parameters or return values.
Those parameters or functions are of the type int. In such cases TRUE and FALSE represent 1 and 0, respectively.

They can be used in upper case (TRUE / FALSE) and lower case (true / false).

Non-Primitive Data Types (Structures)

Complex data types, so-called structures, consist of different elements. The elements of a structure are accessed by
their names in the following way: nameOfVariable.nameOfElement. For example, col.r, if colis a variable of data type
color. The following table is an overview of the structures MADRIX Script provides.

Structure Elements Description
= intr color stores a color value.
color = intg . .

= intb There are 5 channels (red, green, blue, white, alpha) with values

. intw between 0 and 255.

= inta
Example: color c = {255, 255, 0, 0};
Member examples: c.r, c.g, c.b, c.w, c.a
Learn more »
»

= int day date stores a date.

date = int weekday

= int month Values for day include 1 to 31 for a single day of the month.

= int year Values for weekday include: 0 = Sunday, 1 = Monday, ..., 6 =
Saturday.
Values for month include 1 to 12 for every single month of the
year.
Vales for yearinclude year dates.
Example: date d = {24, 11, 1980};
Member examples: d.day, d.weekday, d.month, d.year
»
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int escapement
int orientation
int weight

int italic

int underline
int strikeOut
int charset

int outprecision
int clipprecision
int quality

int pitch

int family

string fontname

int hour time stores a certain time.
time int min
int sec Valid values are: hours: 0 .. 23, minutes: 0 .. 59, seconds: 0 ..
59.
Example: time t = {12, 05, 00};
Member examples: t.hour, t.min, t.sec
»
font int height font stores a specific font face.
int width

height specifies the size of the font and requires an integer
value.

width specifies the wideness of the font and requires an integer
value.

escapement specifies the desired rotation angle in tenths of a
degree and requires an integer value.

orientation should be set to the same value as escapement and
requires an integer value.

weight specifies the weight of the font. Valid values are:
FONT_W\EI GHT_DONTCARE
FONT_VEI GHT_THI N
FONT_WEI GHT _EXTRALI GHT
FONT_WEI GHT_LI GHT
FONT_W\EI GHT_NORMAL
FONT_WEI GHT_MEDI UM
FONT_WEI GHT_SEM BOLD
FONT_WEI GHT_BOLD
FONT_WEI GHT _EXTRABOLD
FONT_VEI GHT _HEAVY

italic specifies the sloping of the font and requires an integer
value:
0 (off) or 1 (on).

underline draws a line under the font and requires an integer
value:
0 (off) or 1 (on).

strikeOut draws a line through the middle of the font and
requires an integer value:
0 (off) or 1 (on).

charset specifies the character set of the font. Valid values are:
CHARSET _ANSI

CHARSET_DEFAULT
CHARSET_SYMBCL
CHARSET_SHI FTJI' S
CHARSET_HANGEUL
CHARSET_HANGUL
CHARSET_(GB2312
CHARSET_CHI NESEBI Gb
CHARSET_CEM
CHARSET_JOHAB
CHARSET_HEBREW
CHARSET_ARABI C
CHARSET_GREEK
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CHARSET_TURKI SH
CHARSET_VI ETNAMVESE
CHARSET_THAI
CHARSET _EASTEUROPE
CHARSET_RUSSI AN
CHARSET_MAC
CHARSET_BALTI C

outprecision specifies how closely the output must match the
requested height, weight, and other attributes of a font. Valid
values are:

PRECI S_OUT_DEFAULT

PREC!I S_OUT_STRI NG

PREC!I S_OUT_CHARACTER
PRECI S_OUT_STROKE

PRECI S _OUT_TT

PRECI S_OUT_DEVI CE

PRECI S_OUT_RASTER

PRECI S_OUT_TT_ONLY

PRECI S_OUT_OUTLI NE

PREC!I S_OUT_SCREEN_OUTLI NE
PRECI S_OUT_PS_ONLY

clipprecision specifies how to clip characters that are partially
outside the clipping region. Valid values are:

PRECI S _CLI P_DEFAULT

PRECI S_CLI P_CHARACTER

PRECI S_CLI P_STROKE

PRECI S_CLI P_MASK

PRECI S CLI P_LH ANGLES

PRECI S _CLI P_TT_ALWAYS

PRECI S_CLI P_DFA DI SABLE

PRECI S_CLI P_ENMBEDDED

quality specifies the quality of the font. Valid values are:
QUALI TY_DEFAULT

QUALI TY_DRAFT
QUALI TY_PROOF

QUALI TY_NONANTI ALI ASED
QUALI TY_ANTI ALI ASED

QUALI TY_CLEARTYPE

QUALI TY_CLEARTYPE_NATURAL

pitch specifies the pitch of the font. Valid values for are:
Pl TCH_DEFAULT

Pl TCH_FI XED

Pl TCH_VARI ABLE

Pl TCH_MONO_FONT

family specifies the font family that describes the font in a general

way. Valid values are:

FONT_FAM LY_DONTCARE
FONT_FAM LY_ROVAN
FONT_FAM LY_SW SS
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FONT_FAM LY_MODERN
FONT_FAM LY_SCRI PT
FONT_FAM LY_DECORATI VE

fontname requires a string. For example "Arial".

».
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shape int renderingMode

int shapeAlignment

int shapeRotation

int blendingMode

int originType

float border

float innerGlow

float outerGlow

int innerGlow Interpolation
int outerGlowInterpolation
float proportion

float diagonalLength

shape stores specific information for shapes.

Valid values for renderingMode are:
RENDERI NG_MODE_EXTENDED

RENDERI NG_MODE_SI MPLE

Valid values for shapeAlignment are:
LOOKAT _FRONT

LOOKAT _BACK
LOOKAT LEFT
LOOKAT_RI GHT
LOOKAT_TOP
LOOKAT_BOTTOM
LOOKAT_RANDOM

Valid values for shapeRotation are:
ROTATI ON_CCW 0

ROTATI ON_CCW 90

ROTATI ON_CCW 180

ROTATI ON_CCW 270

ROTATI ON_CW 0

ROTATI ON_CW 90

ROTATI ON_CW 180

ROTATI ON_CW 270

blendingMode is only available for RENDERING_MODE_EXTENDED.
Valid values are:
BLENDI NG_MODE_NONE

BLENDI NG_MODE_ALPHA

Valid values for originType are:
ORI G N_CENTER

ORI G N_FRONT

ORI G N_BACK

ORI G N_LEFT

ORI G N_RI GHT

ORI G N_TOP

ORI Gl N_BOTTOM

ORI Gl N_TOP_LEFT

ORI Gl N_TOP_RI GHT

ORI Gl N_BOTTOM LEFT

ORI Gl N_BOTTOM RI GHT

ORI Gl N_FRONT_LEFT

ORI Gl N_FRONT_RI GHT

ORI Gl N_BACK_LEFT

ORI G N_BACK_RI GHT

ORI Gl N_FRONT_TOP

ORI Gl N_FRONT_BOTTOM
ORI G N_BACK_TOP

ORI Gl N_BACK_BOTTOM

ORI Gl N_FRONT_TOP_LEFT
ORI Gl N_FRONT_TOP_RI GHT
ORI Gl N_FRONT_BOTTOM LEFT
ORI Gl N_FRONT_BOTTOM RI GH
ORI Gl N_BACK_TOP_LEFT
ORI Gl N_BACK_TOP_RI GHT
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ORI Gl N_BACK_BOTTOM LEFT
ORI Gl N_BACK_BOTTOM RI GHT

borderis only available for RENDERING_MODE_EXTENDED.
Valid values range from 0.01 to 1.00.

innerGlow is only available for RENDERING_MODE_EXTENDED.
Valid values range from 0.01 to 1.00.

outerGlow is only available for RENDERING_MODE_EXTENDED.
Valid values range from 0.01 to 1.00.

Valid values for innerGlow Interpolation are:

| NTERPOLATI ON_TYPE_LI NEAR

| NTERPOLATI ON_TYPE_EASE_BOUNCE_I N

| NTERPOLATI ON_TYPE_EASE_BOUNCE_OUT

| NTERPOLATI ON_TYPE_EASE_BOUNCE_| NOUT
| NTERPOLATI ON_TYPE_EASE CIRC I N

| NTERPOLATI ON_TYPE_EASE_CI RC_OUT

| NTERPOLATI ON_TYPE_EASE_CI RC_| NOUT

| NTERPOLATI ON_TYPE_EASE_CUBI C_|I N

| NTERPOLATI ON_TYPE_EASE_CuUBI C_OUT

| NTERPOLATI ON_TYPE_EASE_CUBI C_| NOUT
| NTERPOLATI ON_TYPE_EASE_SI NE_I N

| NTERPOLATI ON_TYPE_EASE_SI NE_OUT

| NTERPOLATI ON_TYPE_EASE_SI NE_| NOUT

| NTERPOLATI ON_TYPE_EASE_EXPO I N

| NTERPOLATI ON_TYPE_EASE_EXPO_OUT

| NTERPOLATI ON_TYPE_EASE_EXPO | NOUT

Valid values for outerGlow Interpolation are:
See innerGlow Interpolation

proportion is only available for RENDERING_MODE_EXTENDED and

for SHAPE_TYPE_CROSS_STRAIGHT, SHAPE_TYPE_STAR,
SHAPE_TYPE_3D_CROSS_STRAIGHT, and
SHAPE_TYPE_3D_STAR.

Valid values range from 0.01 to 1.00.

diagonalLength is only available for
RENDERING_MODE_EXTENDED and for SHAPE_TYPE_CROSS,
SHAPE_TYPE_STAR, SHAPE_TYPE_3D_CROSS, and
SHAPE_TYPE_3D_STAR.

Valid values range from 0.01 to 1.00.
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2.1.7.3 Conversion Between Data Types

Introduction

If there are different data types within an expression, they must be converted into the same type. MADRIX Script does

those conversions implicitly, but in most times a warning will be displayed in the Compiler Messages section of the

Script Editor. It is also possible to do those conversions explicitly writing the destination data type in brackets before

the expression, like this:

int i
string s =

= (int)GetBpnPitch();
(string)i;

//if the Pitch was 6.2, i
//s now consists of the characters "42"

is now 6

GetBpmPitch() returns a float value which has to be converted into int before it can be assigned to i. Be aware that the

positions after the decimal point are abridged. Afterwards, the numeric value is assigned to .

The following table shows an overview over possible conversions:

int float string structure bool
expressions
int - Converts the Converts the Is true if the value
value to float. value to string: e. N/A is not 0.
g. 12 ="12".
float Converts the - Converts the Is true if the value
value to int. The value to string: e. is not 0.
decimal part is g. 12.34 = N/A
truncated without "12.34"
rounding off.
string If the string is a number, the string is - Is true if string is
converted into an integer value, N/A not empty.
otherwise it results in 0.
structure Conversion
N/A between different N/A
structures: N/A.

Implicit Conversions With Math Expressions

= If one of the two operands of a math expression is of the type float and the other is of the type int, the int value

is converted to float and the expression results in the data type float.

» If one of the two operands of a math expression is of the type string, the other operand is converted into a string

and the expression results in a string.
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» If the conversion is not possible according to the table above, the compiler prints an error and you have to

correct the expression.

Here are some examples of expressions and their results:

Expression Result Explanation

inti=3/4%*2 0 3/ 4is an integeroperation and results in 0. Hence, the whole
expression results in 0.

3/4.0%*2 1.5 Because 4.0 is a float value, 3 will be converted into float, too. In this
way, 3/ 4.0results in 0.75. Then, 2 is also converted into float since
the other operand is of the type float. And the result is therefore 1.5.

string test = "It is " + "It is 9 o'clock."” Since the first operand is a string, 9 is also converted into a string and
9 + " o'clock." concatenated with the first string.

stringtest =2 +3 + "540" 2 and 3 are both integer and will be added up due to an integer

"40" operation. The second operation has a string as operand and therefore

the other operand will be converted into a string and both are
concatenated together.

2.1.7.4 Arrays

Basics

Many programming languages provide arrays, vectors, lists or any other data type to store dynamic data. Dynamic
data is not known yet when the program is written. For such tasks MADRIX Script provides dynamic arrays. They are

declared like variables, followed by [].

int ailntArray[]; /la 1-dimensional array of integer values
date adDateArray[]; //a 1-dinensional array of dates
float aafFloatArray[][]; //a 2-dimensional array of float val ues

It is also possible to initialize arrays using a list of values. These are described by values separated with commas and
written in curly brackets.

/linitialize an array with 5 integer val ues
int ailntArray[] = {2, 3, 4, 5, 6};
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The operator [expression] provides access to the elements of an array. The expression must result in an integer or
compatible value. The lowest index of an array is 0. This means the first entry of an array is always indexed with O;
an array does not start with 1, but 0. When an element is accessed, the array grows automatically in order to provide
the requested element. It is not necessary nor possible to request the size of an array explicitly. Here is an example to
access an array with integer values.

int ailntArray[];

ai I nt Array[ 0] 10;

ailntArray[ 1] 20;
ai I nt Array|[ 2] ailntArray[3];

After the last access the array will have a length of 4 because 3 was the last accessed element. The initial value of an
element is "0" or an empty string or false. The length-attribute of an array tells the current size of an array, which is

the number of currently provided elements.

The Length Or Size Of Arrays

Each array has a length-attribute. It can be accessed through the "."-operator which is also used to access elements

from a structure.

int | = ailntArray.length; //store length of the array in |

Note: The length of an array is defined by the highest index that was used to request an element.

Multi-Dimensional Arrays

Up to this point, one-dimensional arrays were introduced. But multi-dimensional arrays are also possible. To declare a
multi-dimensional array, a "[]" must be added to its declaration for each dimension. Up to now, the only limit to the
number of possible dimensions is set by the resources of the computer on which the script/macro is running. It is also
possible to initialize arrays using a list of elements for each dimension. Here are some examples:

int aaArray[][]; /1a 2-dinensional array
int aaaArray3[][]1[]; //a 3-dinensional array

/linitializes the array with two di mensions and three val ues each
int aaArry2[][] = {{2, 3, 4}, {6, 7, 8}};
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/la 2-dimensional array of color elenents

color aaCArray[][] ={
{ {0, 0, 0, 0, 255}, {255, 255, 255}, {255, 255} },
{ {255 }, {255, 255, 255} },
{ {0, 255 }, {255, 255, 255} } };

The operator [expression] accesses a single element of an array, which for a multi-dimensional array may be another
array. In order to access a single element, the applicable index must be used. For example, the 5t element must be
accessed with the index 4, while the first entry has the index 0. The same is true for the attribute length. It returns the
length of the currently accessed array. Here are two examples:

int aaArray[][];
int aArrayl[] = {1, 2, 3, 4, 5, 6}; //intialize the array

aaArray[0] = aArrayl; //assign aArrayl to the first element of aaArray
aaArray[O][aArrayl.l ength] = aFieldl.length + 1;

aaArray[1][0] = 1;

aaArray[1][2] = 2;

Explanation: At the end of this example aaArray consists of two arrays of int values. The first one has a length of 7
and the second one a length of 3 (due to the access of the element with the index 2). These lengths can be received
by reading the length attributes.

WiteText ("Nunber of arrays in aaArray: " + aaArray.length);

WiteText ("Nunber of elenents in aaArray[0]: " + aaArray[O].|ength);
WiteText ("Nunber of elenents in aaArray[1]: " + aaArray[1].l|ength);

Memory Management Of Arrays

Although the memory for arrays is dynamic, you have to think of it beforehand. Think about the following example:

int ai Array[][];
ai Array[10000] [ 10000] = 1,
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After the assignment, the array has indeed a size of 10.000 x 10.000 elements of int values. An int value needs four
bytes and 10.000 * 10.000 * 4 = 4.0000.0000 bytes, add up to around 382 megabytes (MB) of memory. So please

pay attention when using very big arrays.

Full Example

This example just plays with the arrays and its content. It is just to show how to work with arrays and to get a feeling

for them. A better example is given in the chapter »

void InitEffect()
{

}

voi d Render Ef fect ()
{

Set Bpn{ 600) ;

int aaArray[][];
int aArrayl[] = {1, 2, 3, 4, 5, 6};

aaArray[0] = aArrayl;
aaArray[ 0] [aArrayl. | engt h]
aaArray[1][0] = 1,
aaArray[1][2] = 2;

WiteText ("Nunber of arrays in aaArray:
WiteText ("Nunber of elenments in aaArray[0]:
WiteText ("Nunber of elenents in aaArray[1]: "

WiteText ("El ement of
WiteText ("El ement of
WiteText ("El ement of
WiteText ("El ement of
WiteText ("El ement of
WiteText ("El ement of

WiteText ("El enent of
WiteText ("El ement of
WiteText ("El ement of

aaArray[0][0]:
aaArray[0][1]:
aaArray[0][2]:
aaArray[0][3]:
aaArray[0][4]:
aaArray[0][5]:

aaArray[1][0]:
aaArray[1][1]:
aaArray[1][2]:

+ o+ o+ + + o+

+ +

/lintialize the array

/lassign aArrayl to first el enent of aaArray
= aArrayl.length + 1;

' + aaArray. |l ength);

" + aaArray[0].length);
+ aaArray[1].length);

aaArray[0][0]);
aaArray[0][1]);
aaArray[0][2]);
aaArray[0][3]);
aaArray[0][4]);
aaArray[0][5]);

aaArray[1][0]);
aaArray[1][1]);
aaArray[1][2]);
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2.1.7.5 Strings And String Operations
Introduction

MADRIX Script provides several functions to manipulate strings, find substrings, and to perform many more

operations.

Operations On Strings

Assigning Data Types

It is possible to assign integer, float, and strings to another string as shown in the following example:

string s;
string t;

S t;

"Hell o worl d";
5;
3.5;

S
S
S

Furthermore, it is possible to assign single characters of a string to a character of another string like shown below:

string s, t;

s = "New';
t = "new';
s =t;

s[0] = t[O];

Furthermore, it is possible to assign a double-quoted string to a character of a string. But the assigned string must

have exactly one character. Here is an example:

string s;

s[0] =T
s[1] = "1;
s[2] =".";

The following lines are invalid and will result in a compiler error since the given strings contain more or less than one

character:
s[0] = "New'; //given string has three character but not one
s[0] =""; /1given string is enpty
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Comparing Two Strings

As it is possible to compare two numbers using the compare operators, it is also possible to compare two strings. The

following table provides an overview of the possible operations.

Operator Description

strl == str2 Checks for the equality of two strings.

strl = str2 Checks for the inequality of two strings.

strl < str2 Checks if the first string is less than the second string.

strl <= str2 Checks if the first string is less or equal to the second
string.

strl > str2 Checks if the first string is greater than the other string.

strl >= str2 Cthgcks if the first string is greater or equal to the other
string.

Please note: It is not possible to compare arrays of strings.

Like in the case of assignments, it is also possible to compare single characters of a string against a double-quoted

string with exactly one character:

if(s[0] == "A") ...
else if(s[0] =="1")

It is also possible to compare single characters of a string against integer numbers:

if(s[0] == 1) .
else if(s[0] == 2)

This also works for the switch/case statements. But the "1" as a label of a case means the same as the 1. So the

following two case labels mean the same and this would result in a compiler error:

string s = "1";
switch(s[0])
{
case "1": do sonething; break;
case 1: do sonet hi ng el se; break;
case "A': do sonething; break;
/lis also valid to check for letters and other characters
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Using Strings Within Switch/Case Statements

Another possibility is to use double-quoted strings of one character for of labels. The following theoretical example

demonstrates this:

string s = "New';
for(int i =0; i <s.length; ++i)
{
switch(s[i])
{
case "A": do sonething; break;
case "B": do sonmething el se; break;
case "!": do something; break;
}

Functions For Strings

Function

Description

int findstring(int startIndex, string text, string substring)

This functions looks for the substring in the given text. The
search starts at the given startIndex. The first character
has an index of 0. The function starts its search at a
specified position of the entire text using startIndex and
returns an index that describes the position at which the
substring begins. If the substring is not found, -1 is
returned.

string substring(string text, int startIndex, int count)

The function extracts count characters from the given text
starting with startIndex. If countis -1, all characters of the
string starting at startIndex are returned.

o

int rfindstring(int startIndex, string text, string substring)

This functions looks for the substring in the given text from
its end to the beginning. The function starts its search at a
specified position of the entire text using startIndex and
returns an index that describes the position at which the
substring begins. If the substring was not found, -1is
returned.

int startswith(string text, string substring)

This function checks if the text string starts with the given
substring. If text starts with substring, true is returned,
otherwise false.

int endswith(string text, string substring)

This function checks if the text string ends with the given
substring. If text ends with substring, true is returned,
otherwise false.

int isalnum(string text)

Returns true if the given string contains only characters and
figures and its length is greater then 0, otherwise false is
returned.
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int isalpha(string text)

Returns true if the given string contains only characters and
its length is greater than 0, otherwise false is returned.

int isnum(string text)

Returns true if the given text represents a number. This
may be an integer number or a floating point number (e.g.
1.3). Otherwise it returns false.

void tolower(string text)

Converts each character of the given string into a lower-
case character.

void toupper(string text)

Converts each character of the given string into an upper-
case character.

void strip(string text)

Removes leading and ending white spaces like space,
tabulator, line feeds and so on from the given string.

int stremp(string strl, string str2)

Compares two given strings with each other. If they are
equal, 0 is returned. -1 is returned if stri is less than str2. A
value of 1 is returned if strl is bigger than str2.

void replace(string src, string old, string new)

Replaces any appearances of old within src with new.

void tokenize(string src, string delimiter, string reslist[])

Separates the string src into smaller pieces delimited by
characters within delemiter. The result is returned in reslist.
See for further details.

Tokenizing Strings

The function enables you to tokenize a string. The single tokens will be delimited by the characters within

the second parameter. Each character identifies a single delimiter. The following examples show the usage of the

function and the results.

string s = "Have a wonderful, ni ce day".
string res[];
tokeni ze(s, " ,", res);
string s = "one two, three";
string res[];
tokeni ze(s, "," , res);
Explanation:

= The variable res of the first example will be filled with the following five values: {Have; a; wonderful; nice; day}

= The res variable of the second example will be filled with the following two values: {one two; three}

= The result of the second example will contain only two entries. "one two" is only one entry since the tokens of

the second example are only delimited by coma but not by space.
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Splitting Strings With White Spaces

There is a constant called WHI TE_SPACES which can be used as delimiter in order to split a text by any white spaces

like tabulator, new line, or space.
string s = "Have a wonderful, nice day".
string res[];
t okeni ze(s, WH TE_SPACES, res);

/1 or another exanple which al so uses the comma as delimter
tokeni ze(s, WH TE SPACES + ",", res);

Examples

Substring

This example extracts a part from a string. Insert the source code into the function RenderEffect. As the result "World"
should be displayed in the output window of the Script Editor.
string txt = "Hello Wrld";

string subText = substring(txt, 6, 5); //retrieves "Wrld" fromtxt
WiteText (subText);
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2.1.8 Expressions

Introduction

= Expressions are used to calculate values.

Additionally, they can be assigned to variables or given as parameters to functions.

If an expression is followed by a semicolon, it is called an expression statement.

There are different operators available to write expressions.

Operands For An Expression

An expression is formed of operands and operators. The number of operands depends on the operator. There are
unary operators, which use only one operand, such as "-". And there are binary operators, which need two operands,

like "+".

Operands of an expression can be function calls, variables, constant values like "5" or another expression within
brackets, like (3 + 5).

Assignment Operator

To assign any value to a variable the assignment operator "=" is used in the following way:

vari abl e = expression;

The expression after the "="may be any complex expression. But it has to be compatible with the given variable after
» of MADRIX Script.

float f = cos(0.5);
float f2 = f;
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Math Operations

'++'/'--' Operator

The ++ and -- operators are unary operators and only defined for usage with variables of the type int. They are used
like this:

i ++;

They increment/decrement the variable by one. This operator is known from C/C++. This programming language
offers two possible ways of using them, as suffix and as prefix operators (i++ and ++). In MADRIX Script they are
currently only available as suffix operators (i++) and they work in that way. Such a suffix operator results in the
current value of the given variable and afterwards increments/decrements it.

int i =4
=i+t 2

In the end, i is 8. In the first line, 4 is assigned to the integer value i. In the second line, the expression i++ results in

4. The multiplication therefore is "4 * 2" which results in 8. This value is assigned to i and therefore, i = 8.

'-' Operator

The "-" operator is also available as unary operator and negates the value of the given operand. It supports int- and
float-values.
- 4’

-(3 * 5);
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The "+" operator may also be used as unary operator, but it does not make sense because it does not change the

result of an expression.

Binary Operations

The operators +, -, * and / support int and float values and cause a usual arithmetical addition, subtraction,
multiplication, and division of the two operands.
4 + 4 * 5

(4 + 4) * 5
4 | 5

Operator precedence rules are considered. Note that operations with integer values result in integer values and are
done as integer operations. So 3 / 4 does not result in 0.75 as may be expected, but in 0. To get a result of 0.75, at
least one of the operators must be a float value. An example would be 3.0 / 4, where the 4 is also converted into a

float-value.

Concatenating Strings

The "+" operator can also be used to concatenate strings together.

string s = "Hallo " + "Wlt";
If one of the two operands is of the type string, the other one is converted and the two strings are concatenated
together.

int i = 4;
string s =4 + "th run";

This example results in "4th run". Note that the following example may be misinterpreted since the first part of the

expression is of the type integer and will result in an integer. It is then converted and concatenated into one string.

string s =3 + 4 + "th run";
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The resulting string is "7th run" and not, as perhaps expected "34th run".

Modulo Operation

The modulo operation calculates the integer remainder of an integer division. The operator in MADRIX Script for

modulo operations is %.

10 % 2;

The operator % is only defined for int values.

Additional Assignment Operations

To have less code and increase readability, there are additional assign operators: +=, -=, *=, /=, %=.

i +=3 + 4

is the same as

i =i +(3+4)
and so on.

The resulting source code is much more easy to read.

Operations Of Comparison

With operations of comparison you can test two expressions for a certain relation. Possible comparisons (and
operators) are "less than" (<), "less equal" (<=), "more than" (>), "more equal" (>=), "equal" (==) and "not equal"
('=). Make sure that you can distinguish the meaning of a single equal sign (assignment operator) and a double equal
sign (comparison operator). Operators of comparison always return a bool value, the comparison is either true or
false.

i >4
3 <
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Logical Operations

The '!" Operator

The !-operator is an unary operator, which logical negates the value of the given expression. false becomes true and

vice versa.
13
(3 > 4)
I"Hallo velt"

'And'/'Or' Operator

The and and or-operators are logical operators. They need operands of the data type booland always result in a bool

value. In MADRIX Script the and-operator is expressed via "&&" and the or-operator is declared with "| |".

Unlike C/C++, in MADRIX Script both operands are always evaluated. So, even if the first operand of an "&&" -
operator results in false, this means that the whole expression will be false. But the second operand will be calculated,

too. Here some examples for using those operators:

int i =i || j
int i =(3<4)]] (4>23)
Those operations are usually used within statements, which require to make a decision like the » as

described later on.

Using Operands Of Different Data Types

Operands are automatically converted, e.g. from bool to int, when making an assignment (see also »

).
int i = GetMatrixWdth() > GetMatrixHeight();
int j =(2*sin(Pl) *i) + (2* cos(Pl) * li);
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In the first line, the resulting bookvalue of the ">"-operator is implicitly converted into int and results in 0 or 1. In the

second line, the 2 in both expression parts is converted to float since the sin and the cos functions result in float. The

same holds true for the operands iand /i

Full Example

The following example for the MAS Script Effect uses different expressions to calculate the coordinates on which the

next pixel is to be set. It also calculates the color of the next pixel.

int g_point[];
persi stent color g_color;
void InitEffect()

{

}

g_point[0

1 =0
g_point[1] = O;

color ¢ = {randon{0, 255), randon{0O, 255), randon(0, 255),

g_color = ¢;
Set Bpn( 600) ;

voi d Render Ef fect ()

{

}

//calculate the color for the next pixel

g color.r += (int)(255.0 * (0.5 + 0.5 * sin(g_point[O0]
0.5 * cos(g_point[0]

g_color.b += (int)(255.0 * (0.5 + 0.5 * sin(g_point[O0]
0.5 *

g_color.g += (int)(255.0 * (0.5 +
g_color.w += (int)(255.0 * (0.5 +

[/ make sure, colors are only between 0 and 255
g_color.r % 256;
g_color.g % 256;
g_color.b % 256;
g_color.w % 256;

set Pi xel (g_point);

//setup the next point, x++

[1if x > MatrixWdth x = 0 and y++

[lif y > MatrixHeight y =0

g_point[0] = (g_point[0] + 1) % GetMatrixWdth();
g point[1] = ((int)(g_point[0] == 0) * 1 +

g_point[1]) % Get Matri xHei ght();

void setPixel (int pt[])

{
}

Set Pi xel (g_color, pt[0], pt[1]);

* g_point[0])))
* g_point[1])))
- g_point[1])));
sin(g_point[0] + g_point[1])))

random(0, 255)};
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2.1.9 Statements
Introduction

There are different statements available in a script, for example the if-statement or the call statement to call
functions. Those will be described later on in this chapter. Another statement is the expression statement. A
statement is an expression statement if it is followed by a semicolon. For example:

i =i + 1;
InitEffect();

Using Blocks

A block is started and finished (opened and closed) with the help of curly brackets. Blocks may be used to group
different statements together. There are also different statements which require a block if more than one statement

should be executed. For example the while or the if statement are good examples.

2.1.9.1 'If' And 'Else If' Statements

'If' Construct

Very often it is necessary to make decisions within a script/macro. You could for example want to use red as your
background color every day if it is after 9 a.m. Or for example, it could be your wish to clear the matrix and change
the color if the matrix has been filled up completely. Therefore, in MADRIX Script the keywords if and else exist. The
may be used like this:
i f(condition)
st at enent

el se
st at enent

The first statement is executed if the given condition is true or unequal to 0. Otherwise the second statement, stated

after else, is executed.

Statement may include a single statement or a block of statements and the else-part is optional. Here are some

examples for the if-statement:

if(x %2 == 0)
{
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y);

col.r = 0;
Set Pi xel (col, X, y);
}
el se
{
col.r = 255;
Set Pi xel (col, x,
}

if(testPixel(x, y) '=0)

{
Set Pi xel (WH TE, X,

}

if(x +2>y)
y++;

y);

It is important to consider that an else always refers to the last if-statement. However, blocks may be used to make

the intention clear. To give you a demonstration, please consider the following example. It may be interpreted wrong

since i will be incremented if the j > condition fails and not if the i > 3-condition fails, as is implied by the given else.

if(i > 3)
if(j >1i)
o=
el se
i ++;

1

To let the compiler create the correct code, use blocks:

if(i > 3)
{
if(j >1i)
o=
}
el se
i ++;

'Else If' Construct

Else ifis an additional structure to implement decisions. It may be used like this:

i f(condition)
st at enent

else if (condition)
st at enent
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Like described above, else is always followed by a statement. And if is such a statement. Then, it is logical that an

else can be directly followed by an if. The else if structure is very useful to make code with lot a lot of decisions more

readable. It enables you to check for different conditions, which shall only be checked if the previous condition was

passed successfully. Here is an example which selects another color for different days. Simply copy it and paste it in

the function RenderEffect.

date t = GetDate();

col or c;
if(t.day < 11)
c.r = 255;

else if(t.day <=

c.g = 255;

else if(t.day <=

c.b = 255;
el se

c = WH TE;
Clear(c);

Full Example

21)

31)

The following example for the MAS Script Effect renders a blinking cross onto the matrix. Instead of using random

colors, predefined colors will be used. During each call of RenderEffect, the color will be chosen.

color col Cross = {0, 255, 255, 255};

int g_iCol;

void InitEffect()

{
g_i Col = 0;
Set Bpn{ 300) ;
}

voi d RenderEffect ()

{

int x, vy;

if(g_iCol ==

{

col Cross.
g_i Col = 1,

}

0)

r

else if(g_i Col

{

col Cross.r

g_i Col =

}

el se

{

col Cross.r
= 0;

g_i Col

2;

255;

1)

155;

0;
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for(int x = 0; x < GetMatrixWdth(); x++)
for(int y =0; y < GetMatrixHeight(); y++)
{
if(x ==1y)
Set Pi xel (col Cross, X, VY);
else if(GtMatrixWdth() - x-1 ==y)
Set Pi xel (col Cross, X, VY);
el se
Set Pi xel (BLACK, X, Y);
Y/ I for[each line]

2.1.9.2 'Switch' Statements

Introduction

If it is required to compare an integer variable with a lot of different values, using of the if-statement may be very
impractical. In this case the switch-statement may help. It has the following syntax:

sw t ch( expressi on)

{

case | abel 1:

list of statenents
case | abel 2:

list of statenents
defaul t:

list of statenents

The expression must result in int or a compatible data type which can be converted implicitly. The default-label is
optional. The label must result in a constant value. It is possible to use integer values like "0" or "12", constant
variables, or double-quoted strings like "A". After the colon, one or more statements may follow. But blocks are also

allowed. Moreover, each label has to be unique.

Labels are not an independent block of source code, but a marker where the code execution should be continued if the
expression has the corresponding value. So after execution of the statements for label 1 the statements of label 2 will
be executed and so on. In order to avoid that behavior, use the keyword break. If the expression does not match any

of the given labels, the execution will be continued with the default-label.

The following sample code writes the name of the current day into the message window of the editor.

date d = CGetDate();
swi t ch(d. weekday)

{
case 0: WiteText ("Sunday"); break;
case 1. WiteText ("Mnday"); break;
case 2: WiteText (" Tuesday"); break;
case 3: WiteText ("Wednesday"); break;
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case 4: WiteText (" Thursday"); break;
case 5. WiteText("Friday"); break;
case 6: WiteText ("Saturday"); break;

Now, we are also able to shorten the usage of the if-statement from the last example for the MAS Script Effect in the

following way:

color col Cross = {0, 255, 255, 255};

int g_iCol;
void InitEffect()
{
g_i Col = 0;
Set Bpm( 300) ;
}
voi d Render Effect ()
{
int x, vy;
switch(g_i Col)
{
case O:
col Gross.r = 255;
g_i Col =1,
br eak;
case 1:
col Gross.r = 155;
g_i Col = 2;
br eak;
defaul t:
colCross.r = 0;
g_i Col = 0;
br eak;
Y/ /switch[current color]
for(int x = 0; x < GetMatrixWdth(); x++)
{
for(int y =0; y < GetMtrixHeight(); y++)
{
if(x ==y)
Set Pi xel (col Cross, X, VY);
else if(GetMatrixWdth() - x-1 ==y)
Set Pi xel (col Cross, X, VY);
el se
Set Pi xel (BLACK, X, VY);
Y/ I for[each line]
}
}
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Using Constant Variables

As mentioned earlier, it is possible to use variables declared as constants, but it is necessary that the compiler is able

to compute the value during compilation time. Here is an example with a valid as well as an invalid case label.

const int |abell
const int |abel?2

1
Cet Matri xWdt h();

swi t ch( <sonet hi ng>) {

case | abel 1: do sonet hi ng
br eak;

case | abel 2: do sonething el se
br eak;

The first label (labell) is a valid case label since the compiler is able to compute the value of 1 during compilation
time. The second label (label2) is invalid since it is computed during runtime and therefore it is not a constant value

for the compiler, even though it is not possible to change its value later on.

The following examples are all valid case labels since the compiler can compute their values:

const int labell = 2 + 4;
const int label2 = labell + 3;
const int |abel3 = |abel 2;

Using Double-Quoted Strings

It is also possible to use double-quoted strings for case labels. But they have to have the length of 1. Here is an

example:

void witeText(string s)

{
for(int i =0; i <s.length; i++)
{
switch(s[i])
{
case "A": do sonething; break;
case "B": do sonething with b; break;
}
}
}
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2.1.9.3 'For' And 'While' Loops

Introduction

Loops are used in programming languages to repeat tasks. For example, every pixel should be set to a green color.
Loops run as often as a given condition is true. MADRIX Script offers two possible forms of loops, the for-loop and the

while-oop. Both are similar to the loops in the programming language C.

'While'-Loop

The while-loop is built in this way:

whi | e(condi tion)
st at ement

The statement may be a single expression statement. If more then one statement needs to be executed, a block is

needed, as shown in the following example:

int x = 0;

whi l e(x < 10)

{
Set Pi xel (WH TE, x, 0);
X++;

'For'-Loop

The for-loop is built like this:

for(initialization; condition; expression)
st at ement

This is the same as:

initialization;
whi | e(condi tion)
{
st at enent ;
expr essi on;
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The initialization-part may contain the declaration of a new variable or an expression. It is executed the first time the
loop runs. There may be different initializations separated by comma. Newly declared variables only exist within the
for-loop. After initialization, the condition is checked. If it is unequal to 0, the given statement is executed. (In this
respect, a value of 0 represents false. But a while loop will only be executed, if the condition is true. And true is

represented by a value of 1, which in turn is unequal to 0.)

The condition-part contains an expression. As long as the given expression is not 0 or false, the given statement is

executed. If the condition-part is empty as discussed beneath, it will be interpreted as true.

The expression in the expression-part is executed each time before running the statement and before checking the

condition. But not the first time. There may be different expressions separated by comma.

It is possible to leave different parts of the for-loop empty. But semicolons are necessary, nevertheless. This may be
used to implement the initialization outside the loop. Here are three examples for for-loops. The first one is an endless

loop:

for( ; ;)
{

}

do anyt hi ng;

for(int x = 0; x < GetMatrixWdth(); x++)
for(int y =0; y < GetMatrixHeight(); y++)
Set Pi xel (WH TE, X, Yy);

for(int x = 0; x < GetMatrixWdth(); x++)

{
if(x %2)
DrawPi xel Li ne(WH TE, x, 0, x, GetMatrixHeight());
el se
Dr awPi xel Li ne( BLACK, x, 0, x, GetMatrixHeight());
}
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Controlling Loops: 'Break' And 'Continue’

There are two possibilities to control a loop. First, it is possible to interrupt the execution of a loop (break).

Furthermore, there is a way to skip the rest of the statements of the loop and to go to its beginning (continue).

'Break’

With the keyword break a loop can be quit immediately. For example:

int x = 0;
whil e(x < 10)

{
if(i >= GetMatrixWdth())
break; //1eave | oop now

Set Pi xel (WH TE, x, 0);
X++;

The execution of the script is continued after the loop. No other statement within the loop is executed after break.

'Continue’

With the keyword continue it is possible to skip the rest of the statements within a loop and to start anew. For

example:

int x = 0;
whil e(x < 10)
{
if(x %2 == 0)
conti nue;
Set Pi xel (WH TE, x++, 0);
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Examples

'While' Loop

The following example for the MAS Script Effect draws parts of a cosinus curve onto the matrix while changing the

background color.

void InitEffect()

{
}

Set Bpn{ 300) ;

voi d Render Effect ()

{

color col = {200, 200, 100, 200};
col or col BK={randon{ 0, 150), randon{0, 255),
// set background

Cl ear (col BK);

[/ draw cosi ne curve

int px 0;

int py 0;

float vy;

float t = 0;

whil e(px < GetMatrixWdth())

{

y = cos(t) * GetMatrixHeight();
py = (int)y;
t =t + (Pl
px++;
Set Pi xel (col, px, py);

Y /while[x < GetMatrixWdth()]

* 3/ GetMatrixHeight());

'For' Loop

randon{ 0, 100),

randon( 0, 255) } ;

Here is another full example for the MAS Script Effect which uses fields to store random colors and to fill the matrix

with them.

persistent color g MatrixColors[][];
voi d Render Ef f ect ()

{

random col or
= {random( 0, 255),

/] sel ect
col or col randon( 0, 255),
|/ sel ect random pi xel coordi nates

int px = random(0, Get Matri xWdth()-1);

int py = random(0, Get Matri xHei ght()-1);

randon( 0, 255),

randon( 0, 255) };
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// save the sel ected col or
g_Matri xCol ors[ px] [ py] = col;

//draw points of the array
for(px = 0; px < GetMatrixWdth(); px++)
{
for(py = 0; py < GetMatrixHeight(); pyt++)
{
Set Pi xel (g_Matri xCol ors[ px][py]l. pPX. PY);
Y/ I for[each line]
}//for[each col um]

}
void InitEffect()
{
for(int x = 0; x < GetMatrixWdth(); x++)
for(int y =0; y < GetMatrixHeight(); y++)
{
g_MatrixColors[x][y].r = 0;
g_MatrixColors[x][y].g = O;
g_MatrixColors[x][y].b = O;
g_MatrixColors[x][y].w = O;
}
Set Bpn{( 100) ;
}

2.1.10 Reading From External Files

Asynchronous File Reading

The function

i nt ReadAsync(string file, string txt)

reads content as text from a file into the string txt. The file is opened and closed automatically. There is no "open"
function like in other programming languages. The parameter file may contain a filename of a local file, like "C:
\config.bxt". In addition, the HTTP protocol is supported. That means it is possible to retrieve data from a web server.
For example: "http://www.madrix.com". The following examples would read some content from different files.

string txt;

ReadAsync("C \config.txt", txt);
ReadAsync("http://ww. testserver.de/testfile.txt");

Here is an example which reads some numbers from a file (to be found at C:\temp\src.txt) and renders a curve on

the matrix.

float g_pos[] = {0.8, 0.5};

www.madrix.com /176



MADRIX 3 Script Help and Manual Version 2.15. [Part B] MADRIX Script (Introduction)

string file = "C \tenmp\src.txt";
string txt;

void InitEffect()

{
Set Bpn{ 300) ;

}

voi d RenderEffect()

{
ShiftVectormatrix(0.0, 0.0, 1.0, 1.0, SH FT_LEFT, 0.1);
ReadAsync(file, txt);
float f = (float)txt;
DrawVect or Li ne(WH TE, g_pos[0], g_pos[1], g_pos[0] + 0.1, f);
g_pos[1] = f;

}

Let's take for example a program which writes the temperature from an external sensor connected to USB to the file
and MADRIX draws the curve onto a matrix. As described later on, it would also be possible to write a macro for the

SCE Ticker effect to display the values as text.

The function can return several codes/status updates for different scenarios:

Value Description
int FI LE_OK The function could read the file without problems.
int FI LE_NOT_EXI ST The specified file does not exist. This is returned if a local file has been specified

that is not there. If the file was a HTTP request, this error is returned when the
file does not exist on the host.

int FI LE_ERROR This is returned if any error occurred while reading the content of a local file.

int | NVALI D_HOST This value is returned if the file was a HTTP request and the specified host does
not exist.

int NETVWORK _ERROR This value is returned on any network error, e.g. if no network adapter is
available or the connection between the host and the client has been
disconnected.

Example

For testing purposes there are two scripts which deliver random numbers at the end of this chapter. Or you could play
with this test set-up for SCE Ticker / Scrolling Text:

@cri pt nane="ReadAsync Test Set-Up";
@ut hor="";

@ersion="";

@escription="";
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string file = "C \tenp\src.txt"; //location of the source text file
string txt;
int interval = 600000; //interval = 10 m nutes

void InitEffect()

{
Set ReadAsynclnterval (file, interval);

}

voi d PreRender Ef f ect ()

{

swi t ch( ReadAsync(file, txt))

{
case FILE OK : WiteText("FILE OK"); SetText(txt); break; // txt is displayed
case FILE NOT_EXI ST : WiteText("FI LE_NOT_EXI ST"); br eak;
case FILE ERROR : WiteText ("FI LE_ERROR'); br eak;
case NETWORK ERROR : Wit eText (" NETWORK_ERRCR') ; br eak;
case | NVALID HOST : WiteText ("1 NVALI D HOST"); br eak;
default : break;
}

}

voi d Post Render Ef f ect ()

{

}

Detailed Information About 'ReadAsync’

As you can see, it is neither necessary to explicitly open the file nor to close it. During the first call of the function, the
specified file is opened. File reading happens asynchronously, which means that the function immediately returns a
value but does not wait for the physical reading. Internally, the file will be read and the content is stored in a buffer.
The function itself just reads from this buffer. This also means that after the first call of the function, it is more likely
that no text will be read. There is a big advantage of this behavior. It is not necessary for the script to wait for

potentially long reading times, which may occur, especially if you read content from internet servers.

Setting The Reading Interval

The file will be continuously read in the background. ReadAsync always receives the result of the last reading process.
It is possible to control the interval of the reading process. The default value is 1000ms which means that an opened

file will be read one time each second. The function

i nt Set ReadAsynclnterval (string file, int interval)
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sets the reading interval for a certain file. The int intervalis given in milliseconds. The minimum reading interval is 10
ms. Imagine your sensor writes data every 500 ms. Therefore, you can set the interval to 500ms in order to let

MADRIX instantly show the values. Or you can set it higher, e.g. to 5000 ms (5 seconds), in order to save resources.

If the file in question has not been opened yet, e.g. by a call of ReadAsync, the file will be opened to begin internal
reading. It makes sense to set the reading interval within the InitEffect function in order to have the content of the file

read before the first call of ReadAsync, which is perhaps located in RenderEffect.

Tips For Using Files In MADRIX Script

Overview

Up to now, MADRIX Script is not designed to operate on strings. There aren't any proper functions available that may
help you to parse strings or even manipulate them. Furthermore, such functionality requires a lot of computing time,
which is not necessarily available within MADRIX and therefore within MADRIX Script. It may be better to have
external tools (e.g. python scripts, PHP, or Visual basic scripts) which prepare files for MADRIX in order to have faster
scripts.

Another interesting possibility is to have interactive scripts. Imagine a small application which retrieves input from an

user and writes it to a file. A script may read the file and react to the input.

The following scripts are external scripts which may be used to test the script above or to play around with the

reading functionality of MADRIX Script. Both scripts deliver random numbers using a local file or via HTTP request.

A Python Script To Create Random Numbers

The following script creates random values between 0 and 1 and writes them to the file "C:\temp\src.txt". In order to
use a different file, set the file variable in the third line of the script to a different one. Please do not forget to change
the script above to read the same file. Each second one value is written. In order to test HTTP functionality, this script
may also run on a web server and you can request the written file from the web server.

import tine
i mport random

file ="C/tenmp/src.txt"
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whil e True:

f = random randomn()

s = "%2f" %f

try:
wf = open(file, "w')
w.wite(s)
wf . cl ose()

except :
print "Can't open file"

print "Wert %2f" 9%

tine. sl eep(l1)

A PHP Script To Create Random Numbers

The following PHP script delivers a random number between 0 and 1 each time it is called.

<?php
echo (rand() / getrandmax())
?>

2.1.11 Using Comments

During your study of this manual, surely you have encountered source code examples with text that is not part of the

actual script. These so-called comments are a help for the programmer and other users of the script. Comments are

used for a better readability and understandability of the source code.

There are two different kinds of comments in MADRIX Script:

= Single line comments are induced with "//" and they end at the end of the line.

//This is a comrent about a single line

[/ This is the next line

= Multi-line comments are started with "/*" and they end with "*/".

/* a coment starts here

*/ the comment ends here
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2.1.12 Including Extra Information

It is possible to provide some additional information about a script. This includes a script name, a version number, the
author's name, and a description. The information is visible within a script, because it is written into the Script Editor's

input field if it has been loaded as compiled script.

Here is an example on how the information can be included:

@ame="Nane of the script"

@ersion="1.24";

@ut hor="John Smth";

@lescription="Any text which describes the follow ng script.";

As shown above, information is set using the following syntax:

@ NFORVATI ON="any string";

n_n

Values after have to be a string within double quotes. Therefore, it is also possible to set version to "1.2a" or any
other string. Please note case sensitivity. It is not possible to set any of the values within a function and it is
recommended to write the information at the beginning of a script. Overwriting one of the values results in a warning.

The summary contains an » in a script.

2.2 Advanced Techniques

2.2.1 Draw And Render Functions
2.2.1.1 Pixels Vs. Vectors

Introduction

= In a lot of cases, MADRIX Script offers both a pixel-based or a vector-based version of a function.

= When working with a matrix and pixels, the dimensions of matrix and effects, such as a vertical line, are
absolute and adjusted to that particular matrix.

- For example, you might want to draw a 20x2 horizontal line on a 50x50 matrix.

= However, this can be a disadvantage since you might want to write a macro/script that can be applied to a
multitude of matrixes with different sizes or someone else might want to use your script. In this case using
relative values can help a lot, since effects are scalable then.

- For example, the horizontal line should always be of 50% width and 5% height.

- Valid values for relative values range from 0.0 to 1.0.
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Rules Of Calling Functions

Overview

= Functions of MADRIX Script often tell you what their purpose is and which kind of values they require (absolute

or relative).

= The name of a draw or render function often starts with a description of what it does, like Draw or Fill. It is
followed by Pixel or Vector to describe whether the function requires pixel coordinates or relative coordinates.

The final part describes the application of the function, like Rector Line. Here are two examples:

= Fill Pixel Rect - Draws and fills a rectangle using absol ute val ues
= DrawectorCircle - Draws an unfilled circle using relative val ues

Using Absolute Coordinates

» Functions with Pixel in their name operate on absolute pixel values. Imagine a rectangle which is drawn from
x=5, y=5 with a size of 10. The object will always be rendered starting from 5, 5 to 15, 15, on every matrix.
- On the one hand, the rectangle appears to be very small on large matrices.

- On the other hand, on small matrices it seems to be a big rectangle because it fills a larger area of the matrix.

Using Relative Coordinates

» Functions with Vector in their name operate on relative values. 0, 0 stands for the upper left corner of the
effects matrix. 1, 1 describes its lower right corner, or its whole length and height.
- A rectangle which is drawn from 0.25 with a size of 0.5 will look the same on every matrix. Its size is simply
the half of the matrix size.
- On a matrix with more pixels the rectangle is also drawn with more pixels compared to fewer pixels on a
smaller matrix.

- In contrast, the usage of absolute coordinates dictates the utilization of the same amount of pixels.
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2.2,.1.2 Using Flters
Introduction

You can use filters in order to render your output differently.

The functions looks as follows:

= void Filter(int filter);

* This function basically works whenever a matrix is used, which is the case with the MAS Script Effect, Macros for
Effects, the Main Output Macro, and the Storage Place Macro. Insert the function into PostRenderEffect in order

to use it.

Filters are useful tools to manipulate every MADRIX effect, videos, and images.

Several filters can be applied/used at the same time.

For MAS Script Effect, Macros for Effects, and the Storage Place Macro you can also use:

= void SetFilter(int filter);

Types Of Filters

Filters are divided into several groups, such as color correction filters or transformation filters, for example.

Constants for Filters / Storage Place and Layer Effects (FX)

General Filters

int FI LTER_NONE

Deactivates the filter.

Blur/Sharpen Filters

int FI LTER_BLUR

This filter blurs the output.

int FI LTER_BLUR_BSPLI NE

This filter blurs the output applying a
B-spline.

int FI LTER_BLUR_CATMULL_ROM

This filter blurs the output applying a
Catmull-Rom spline.

int FI LTER_BLUR_GAUSS

This filter blurs the output applying
the Gaussian function.
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Constants for Filters / Storage Place and Layer Effects (FX)

int FI LTER_BLUR_M TCHELL

This filter blurs the output applying
the Mitchell-Netravali function.

int FI LTER_SHARPEN

This filter sharpens the output.

Color Correction Filters

int FI LTER_BRI GHTEN

The brighten filter to light up the
whole matrix.

int FI LTER_DARKEN

The darken filter to darken the whole
matrix.

int FI LTER_GRAYSCALE

The grayscale filter to render the
matrix grayscale, i.e. in gray colors.

int FI LTER | NVERT_COLOR

The invert color fitter to invert every
color channel.

Color Mask Filters

int FI LTER_RED

The red filter to filter out every color
except the red color channel.

int FI LTER_GREEN

The green filter to fiter out every
color except the green color channel.

int FI LTER_BLUE

The blue filter to fitter out every color
except the blue color channel.

int FI LTER_VWHI TE

The white filter to filter out every
color except the white color channel.

int FI LTER_RED_GREEN

The red/green filter to filter out every
color except the red and the green
color channel.

int FI LTER_RED_BLUE

The red/blue fiter to filter out every
color except the red and the blue
color channel.

int FI LTER_GREEN_BLUE

The green/blue filter to fiter out
every color except the green and the
blue color channel.

int FI LTER_RED_WHI TE

The red/white filter to fitter out every
color except the red and the white
color channel.

int FI LTER_GREEN_WHI TE

The green/white filter to fiter out
every color except the green and the
white color channel.

int FI LTER_BLUE_WHI TE

The blue/white filter to fiter out every
color except the blue and the white
color channel.

int FI LTER_RED_GREEN_BLUE

The red/green/blue filter to filter out
every color except the red, the green,
and the blue color channel.

int FI LTER_RED_GREEN_WHI TE

The red/green/white filter to fiter out
every color except the red, the green,
and the white color channel.
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Constants for Filters / Storage Place and Layer Effects (FX)

int FI LTER_RED BLUE_WHI TE

The red/blue/white filter to fiter out
every color except the red, the blue,
and the white color channel.

int FI LTER_GREEN_BLUE_W\HI TE

The green/blue/white filter to fiter
out every color except the green, the
blue, and the white color channel.

Style Filters

int FI LTER_EDGES

The edges filter to make the edges of
objects/motifs stand out.

int FI LTER_EDGES_POPUP

The edges popup fiter to make the
edges of objects/motifs stand out.

int FI LTER_EMBOSS

The emboss fiter to create an image
with just highlights and shadows.

int FI LTER_EMBOSS_POPUP

The emboss popup filter to create an
image with just highlights and shadows
depending on the motif.

Transformation Filters

int FI LTER | NVERT_H_MATRI X

The filter flips the matrix horizontally.

int FI LTER_| NVERT _V_MATRI X

The filter flips the matrix vertically.

int FI LTER_| NVERT_HV_MATRI X

The filter flips the matrix horizontally
and vertically. Therefore it instantly
rotates the matrix by 180°.

int FI LTER_| NVERT_D_MATRI X

The filter flips the matrix regarding the
depth.

int FI LTER_| NVERT_HD_MATRI X

The filter flips the matrix horizontally
and regarding the depth.

int FI LTER_| NVERT_VD_NATRI X

The filter flips the matrix vertically and
regarding the depth.

int FI LTER_| NVERT_HVD_NMATRI X

The filter flips the matrix horizontally,
vertically, and regarding the depth.

Deprecated Functions

Deprecated functions are outdated functions and should not be used anymore.

Function/Constant Description

int FI LTER_GREYSCALE Use int FI LTER_GRAYSCALE instead.
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Example

Paste the following example into the Main Output Macro Editor to see how this filter inverts all colors of your main

output.

@criptname="Filter: Invert Colors";
@ut hor="";

@ersion="2.8";

@escription="";

void InitEffect()

{}

voi d PreRender Ef f ect ()

{}

voi d Post Render Ef f ect ()

{ Filter(FILTER | NVERT_COLCR);
}

2.2,1.3 Using Mix Modes

Available Functions

The function SetMixMode offers the possibility to set the mix mode of a Layer. The function GetMixMode retrieves the

mix mode currently in use. They are declared as follows:

e void Set M xMode(i nt node)
*int GetM xMbode()
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For the parameter mode one of the values described in the table below must be used. If mode has an invalid value,

nothing will happen and a message will be displayed inside the Script output window of the Script editor. You can find

more information about mix modes and their usage in the MADRIX manual.

Available Parameters

Identifier/ Mix Mode

Description

int M XMODE_ NORIVAL The Normal mix mode.

int M XMODE_ DARKEN The Darken mix mode.

int M XMODE_MULTI PLY The Multiply mix mode.

int M XMODE_ COL ORBURN The Color Burn mix mode.
int M XMODE_ LI NEARBURN The Linear Burn mix mode.
int M XMODE_LI| GHTEN The Lighten (HTP) mix mode.
int M XMODE_ SCREEN The Screen mix mode.

int M XMODE_ COL ORDODGE The Color Dodge mix mode.
int M XMODE_ LI NEARDODGE The Linear Dodge mix mode.
int M XMODE_ OVERLAY The Overlay mix mode.

int M XMODE_SOFTLI GHT The Soft Light mix mode.
int M XMODE_HARDLI| GHT The Hard Light mix mode.
int M XMODE_VI VI DLI GHT The Vivid Light mix mode.
int M XMODE_LI NEARLI GHT The Linear Light mix mode.
int M XMODE_PI NLI GHT The Pin Light mix mode.

int M XMODE_HARDM X The Hard Mix mix mode.

int M XMODE_ DI FFERENCE The Difference mix mode.

int M XMODE_EXCLUSI ON The Exclusion mix mode.

int M XMODE_AND

The AND mix mode.

int M XMODE_OR The OR mix mode.
int M XMODE_ XOR The XOR mix mode.
int M XMODE_NAND The NAND mix mode.
int M XMODE_NOR The NOR mix mode.
int M XMODE_ MASK The Mask mix mode.
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2.2,.1.4 Mapping / Tiling / Rotation

Overview

» MADRIX provides advanced mapping functionality, including mapping, tiling, and rotation.

= The following functions are available for the MAS Script Effect as well as Macros for Effects for usage in MADRIX

Script.

» The Storage Place Macro provides its own functions. Learn more: »

Functions
Function Description oot il Il BN
Effect Place Macro
s Macro
int MapDlgIsMapped() Retrieves if the Layer is mapped. + +
void MapDIgGetMapVector(float | Retrieves the map settings for the Layer using relative + +
map[]) values. The values are saved in a array (map[]).

= map[0] = X-coordinate (Position X)

= map[1] = Y-coordinate (Position Y)

map[2] = width (Size X)

= map[3] = height (Size Y)

void MapDlgSetMapVector(float | Maps the Layer to a certain area of the matrix using relative | + +
x, float y, float w, float h) values. x and y describe the coordinates. w and h describe
width and height, respectively.

void MapDIlgGetMapVector3D Retrieves the map settings for the Layer in 3D using + +
(float map[]) relative values. The values are saved in an array (map[]).

= map[0] = X-coordinate (Position X)
» map[1] = Y-coordinate (Position Y)
= map[2] = Z-coordinate (Position Z)
= map[3] = width (Size X)
= map[4] = height (Size Y)

= map[5] = depth (Size 2)
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void MapDIlgSetMapVector3D
(float x, float vy, float z, float w,
float h, float d)

Maps the Layer to a certain area of the matrix in 3D using
relative values. x, y, and z describe the coordinates. w, h,
and d describe width, height, and depth.

void MapDlgGetMapPixel(int
map[])

Retrieves the map settings for the Layer using pixel values.
The values are saved in an array (map[]).

= map[0] = X-coordinate (Position X)

= map[1] = Y-coordinate (Position Y)

map[2] = width (Size X)

= map[3] = height (Size Y)

void MapDlgSetMapPixel(int x,
int y, int w, int h)

Maps the Layer to a certain area of the matrix using pixel
values. x and y describe the coordinates. w and h describe
width and height, respectively.

void MapDIlgGetMapPixel3D(int
map([])

Retrieves the map settings for the Layer in 3D using pixel
values. The values are saved in an array (map[]).

= map[0] = X-coordinate (Position X)
= map[1] = Y-coordinate (Position Y)
= map[2] = Z-coordinate (Position Z)
= map[3] = width (Size X)
= map[4] = height (Size Y)

= map[5] = depth (Size Z)

void MapDlgSetMapPixel3D(int
X, int y, int z, int w, int h, int d)

Maps the Layer to a certain area of the matrix in 3D using
pixel values. x, y, and z describe the coordinates. w, h, and
d describe width, height, and depth.

int MapDIgGetMapMode()

Retrieves the currently used Map Mirror Mode of the
Layer. See for a list of constants.

void MapDIlgSetMapMode(int
mode)

Sets the Map Mirror Mode for the Layer. See for a
list of constants.

void MapDlgGetTileVector(float
tile[1)

Retrieves the Tiling settings for the Layer using relative
values. The values are saved in an array (tile[]).

= tile[0] = X-coordinate (Position X)
= tile[1] = Y-coordinate (Position Y)
= tile[2] = width (Size X)

= tile[3] = height (Size Y)

void MapDlgSetTileVector(float
x, float y, float w, float h)

Tiles the Layer to a certain area of the mapping using
relative values. x and y describe the coordinates. w and h
describe width and height, respectively.
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void MapDlgGetTileVector3D
(float tile[])

Retrieves the Tiling settings for the Layer in 3D using
relative values. The values are saved in an array (tile[]).

= tile[0] = X-coordinate (Position X)
= tile[1] = Y-coordinate (Position Y)
= tile[2] = Z-coordinate (Position Z)
= tile[3] = width (Size X)
= tile[4] = height (Size Y)

= tile[5] = depth (Size Z)

void MapDlgSetTileVector3D
(float x, float vy, float z, float w,
float h, float d)

Tiles the Layer in a certain area of the mapping in 3D using
relative values. Layer indexing (number) starts with 0. x, y,
and z describe the coordinates. w, h, and d describe
width, height, and depth.

void MapDlgGetTilePixel(int tile
(H

Retrieves the Tiling settings for the Layer using pixel
values. The values are saved in an array (tile[]).

tile[0] = X-coordinate (Position X)

tile[1] = Y-coordinate (Position Y)

tile[2] = width (Size X)

tile[3] = height (Size Y)

void MapDlgSetTilePixel(int x, int
y, int w, int h)

Tiles the Layer in a certain area of the mapping using pixel
values. x and y describe the coordinates. w and h describe
width and height, respectively.

void MapDlgGetTilePixel3D(int
tile[1)

Retrieves the Tiling settings for the Layer in 3D using pixel
values. The values are saved in an array (tike[]).

tile[0] = X-coordinate (Position X)
= tile[1] = Y-coordinate (Position Y)
= tile[2] = Z-coordinate (Position Z)
= tile[3] = width (Size X)
= tile[4] = height (Size Y)

= tile[5] = depth (Size Z)

void MapDlgSetTilePixel3D(int x,
int y, int z, int w, int h, int d)

Tiles the Layer in a certain area of the mapping using pixel
values. x, y and z describe the coordinates. w, h, and d
describe width, height, and depth.
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void MapDlgGetTileOffsetVector
(float offset[])

Retrieves the Tiling Offset of the Layer using relative
values. The values are saved in an array (offset[]).

= offset[0] = X-coordinate (Offset X)

= offset[1] = Y-coordinate (Offset Y)

void MapDlgSetTileOffsetVector
(float x, float y)

Sets the Tiling Offset of the Layer using relative values. x
describes Offset X, while y represents Offset Y.

void
MapDIgGetTileOffsetVector3D
(float offset[])

Retrieves the Tiling Offset of the Layer in 3D using
relative values. The values are saved in an array (offset[]).

= offset[0] = X-coordinate (Offset X)
= offset[1] = Y-coordinate (Offset Y)

» offset[2] = Z-coordinate (Offset Z)

void
MapDlgSetTileOffsetVector3D
(float x, float vy, float z)

Sets the Tiling Offset of the Layer in 3D using relative
values. x describes Offset X, y describes Offset Y, while z
represents Offset Z.

void MapDIlgGetTileOffsetPixel
(int offset[])

Retrieves the Tiling Offset of the Layer using pixel values.
The values are saved in an array (offset[]).

» offset[0] = X-coordinate (Offset X)

= offset[1] = Y-coordinate (Offset Y)

void MapDlgSetTileOffsetPixel
(int x, int y)

Sets the Tiling Offset of the Layer using pixel values. x
describes Offset X, while y represents Offset Y.

void
MapDIgGetTileOffset Pixel3D(int
offset[])

Retrieves the Tiling Offset of the Layer in 3D using pixel
values. The values are saved in an array (offset[]).

» offset[0] = X-coordinate (Offset X)
» offset[1] = Y-coordinate (Offset Y)

= offset[2] = Z-coordinate (Offset Z)

void
MapDIgSetTileOffset Pixel3D(int
X, int y, int 2)

Sets the Tiling Offset of the Layer in 3D using pixel
values. x describes Offset X, y describes Offset Y, while z
represents Offset Z.

int MapDIgGetTileMode()

Retrieves the currently used Tile Mode of the Layer. See
for a list of Tile Mode constants.

void MapDlgSetTileMode(int
mode)

Sets the Tile Mode of the Layer. See
Mode constants.

for a list of Tile
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void MapDlgGetRotationVector
(float rot[])

Retrieves the Rotation values for axes x, y, and z of the
Layer using relative values. The values are saved in an array

(rot[].
= rot[0] = X-coordinate (X-Axis)
= rot[1] = Y-coordinate (Y-Axis)

= rot[2] = Z-coordinate (Z-Axis)

void MapDlgSetRotationVector
(float x, float vy, float z)

Sets the Rotation values for axes x, y, and z of the Layer
using relative values.

void MapDlgGetRotationDegree
(int rot[])

Retrieves the Rotation values for axes x, y, and z of the
Layer using degree values.The values are saved in an array

(rot[]).
= rot[0] = X-coordinate (X-Axis)
= rot[1] = Y-coordinate (Y-Axis)

= rot[2] = Z-coordinate (Z-Axis)

void MapDlgSetRotationDegree
(int x, int y, int z)

Sets the Rotation values for axes x, y, and z of the Layer
using degree values.

float
MapDlgGetRotationXVector()

Retrieves the Rotation for the X-axis of the Layer using
relative values.

void
MapDlgSetRotationXVector
(float value)

Sets the Rotation value for the X-axis of the specified
Layer using degree values.

int MapDIgGetRotationXDegree
0

Retrieves the Rotation for the X-axis of the Layer using
degree values.

void
MapDlgSetRotationXDegree(int
value)

Sets the Rotation value for the X-axis of the Layer using
degree values.

int MapDIgGetRotationXMode()

Retrieves the Rotation mode for the X-axis of the Layer.
See for a list of Rotation Mode constants.

void MapDlgSetRotationXMode
(int mode)

Sets the Rotation mode for the X-axis of the Layer. See
for a list of Rotation Mode constants.

float
MapDlgGetRotationYVector()

Retrieves the Rotation for the Y-axis of the Layer using
relative values.

void
MapDligSetRotationYVector
(float value)

Sets the Rotation value for the Y-axis of the Layer using
relative values.

int MapDIgGetRotationYDegree
0

Retrieves the Rotation for the Y-axis of the Layer using
degree values.

void
MapDigSetRotationYDegree(int
value)

Sets the Rotation value for the Y-axis of the Layer using
degree values.

int MapDIgGetRotationYMode()

Retrieves the Rotation mode for the Y-axis of the Layer.
See for a list of Rotation Mode constants.
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void MapDlgSetRotationYMode
(int mode)

Sets the Rotation mode for the Y-axis of the Layer. See
for a list of Rotation Mode constants.

float
MapDlgGetRotationZVector()

Retrieves the Rotation value for the Z-axis of the Layer
using relative values.

void
MapDlgSetRotationZVector
(float value)

Sets the Rotation value for the Z-axis of the Layer using
relative values.

int MapDIgGetRotationZDegree
()

Retrieves the Rotation value for the Z-axis of the Layer
using degree values.

void
MapDlgSetRotationZDegree(int
value)

Sets the Rotation value for the Z-axis of the Layer using
degree values.

int MapDIgGetRotationZMode()

Retrieves the Rotation mode for the Z-axis of the Layer.
See for a list of Rotation Mode constants.

void MapDlgSetRotationZMode
(int mode)

Sets the Rotation mode for the Z-axis of the Layer. See
for a list of Rotation Mode constants.

void MapDlgGetRotationMode
(int mode[])

Retrieves the Rotation mode for axes x, y, and z of the
Layer. See for a list of Rotation Mode constants. The
values are saved in an array (mode[]).

= mode[0] = X-coordinate (X-Axis)
= mode[1] = Y-coordinate (Y-Axis)

= mode[2] = Z-coordinate (Z-Axis)

void MapDlgSetRotationMode
(int x, int y, int z)

Sets the Rotation Mode for axes x, y, and zof the Layer.
See for a list of Rotation Mode constants.

int MapDIgGetAntiAliasing()

Retrieves the Anti-Aliasing mode of the Layer. See
for a list of Anti-Aliasing Mode constants.

void MapDlgSetAntiAliasing(int
aalLevel)

Sets the Anti-Aliasing mode of the Layer. See fora
list of Anti-Aliasing Mode constants.

Map Mirror Mode Constants

Constant

Description

int MAP_M RROR_NONE

Sets no Mirror Mode.

int MVAP_M RROR_H

Mirrors the content of the matrix horizontally.

int MAP_M RROR_V

Mirrors the content of the matrix vertically.

int MAP_M RROR_HV

Mirrors the content of the matrix horizontally and vertically.

int MAP_M RROR_D

Mirrors the content of the matrix in the depth.

int MVAP_M RROR_HD

Mirrors the content of the matrix horizontally and in the depth.
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Constant Description
int MAP_M RROR_VD Mirrors the content of the matrix vertically and in the depth.
int MAP_M RROR_HVD Mirrors the content of the matrix horizontally, vertically, and in the
depth.

Map Tile Mode Constants

Constant Description
int MAP_TI LE_NONE Sets no Tile Mode.
int MAP_TI LE_REPEAT Repeats tiles on the mapped matrix.
int MAP_TI LE_M RROR_H Mirrors tiles horizontally.
int MAP_TI LE_M RROR_V Mirrors tiles vertically.
int MAP_TI LE_M RROR_HV Mirrors tiles horizontally and vertically.
int MAP_TI LE_M RROR_D Mirrors tiles in the depth.
int MAP_TI LE_M RROR_HD Mirrors tiles horizontally and in the depth.
int MAP_TI LE_M RROR_VD Mirrors tiles vertically and in the depth.
int MAP_TI LE_M RROR_HVD Mirrors tiles horizontally, vertically, and in the depth.

Map Rotation Mode Constants

Constant Description
int MAP_ROTATI ON_FI XED The rotation value is fixed and not animated.
int MAP_ROTATI ON_LOOP The rotation value is used for a looped animation.

Map Anti-Aliasing Mode Constants

Constant Description
int MAP_AA NONE Sets no anti-aliasing.
int MAP_AA 2X Sets simple anti-aliasing (requires some performance).
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Constant Description

int MAP_AA 4X Sets complex anti-aliasing (requires a lot performance).

2.2.1.5 'ShiftMatrix'

The shifting function allows you to move the content of the matrix into a given direction. It is declared as follows:

void ShiftPixel Matrix(int x, int y, int w, int h, int dir, int step)
void ShiftVectorMatrix(float x, float y, float w, float h, int dir, float step)

Again there are two possibilities. One is used with absolute pixel coordinates and values, and one uses relative
coordinates and values between 0 and 1.

= X, y, w, and h define the pixel area that should be shifted.

= step defines how many pixels the content should be shifted into a given direction, which specified by dir.

= For dir » are allowed. If the value of dir is invalid, the default direction SHI FT_TOP

will be used.

The following script for the MAS Script Effect fills the matrix with yellow and draws a red cross onto it during
initialization. During the rendering of the content, the whole matrix is shifted downwards. Hence, the cross is moving

to the bottom of the matrix. You can simply copy and paste it.

void I nitEffect()

{
col or col bg ={255, 255};
col or col ={255};
Cl ear (col bg);
Dr awWect or Cross(col,0.0,0.0,1.0,1.0);
}
voi d Render Ef f ect ()
{
Shi ft Pi xel Matrix(0, 0, Get Matri xWdth(), Get Matri xHei ght (), SH FT_DOM, 1) ;
}
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The script also demonstrates an important behavior of the function. As you can see, the matrix remains yellow, but
the cross moves to the bottom. Furthermore, red lines will be drawn on the left and right side. This is due to the fact
that the Shift function copies the complete content of the matrix and redraws this picture on the new position. While
the the content is moved into the given direction, the original matrix is left unchanged. This leaves the first pixel "line"

unchanged in our example.

2.2.1.6 'DrawPixelArea’

Introduction

Two specific functions will be described in this chapter. First, MADRIX Script provides a function to be able to retrieve
the content of a specific area of the matrix. Second, there is a function which is able to draw pixels onto the matrix

using the obtained data array(s) as source.

Retrieving Content Of The Matrix

The function GetPixelArea retrieves data from the matrix and stores it into a 2-dimensional array of colors. Data is

stored in the background at a certain position of the virtual matrix.

voi d GetPi xel Area(matrix[][], int xSrc, int ySrc, int w, int h,
int xDst, int yDst)

Explanation:

matrix[] is a 2-dimensional array of colors in which the content of the virtual matrix is saved.

xSrc, ySrc describe the position of the source area (upper left corner). The default values are 0.

w, h describe the width and height of the source area. The default values are -1.

A value of -1 means that the whole width or height of the virtual matrix will be retrieved (the complete matrix).

xDst and yDst describe the position of the destination area (upper left corner). The default values are 0.

The retrieved array will be stored in the background. It will be stored at a certain position of a matrix in the
background. As such, you can define an individual target destination.

This behavior allows you, for example, to retrieve multiple source areas by calling GetPixelArea several times
and to draw them only once by calling DrawPixelArea one time (see below).

If your array is larger than your target destination allows, it will be reduced to fit the size of the virtual matrix.
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= In order to retrieve the whole matrix into the given array, it is possible to just call:

color matrix[][];
Get Pi xel Area(matri x);

* Summary: You can store the complete virtual matrix or only parts of it in a array. The array can be stored at the
default position or an individual position. The array is stored on a matrix in the background. The background

matrix acts as source for DrawPixelArea. It can contain several arrays.

Drawing Content Onto The Matrix

The function DrawPixelArea copies data from a 2-dimensional array of colors from the background and renders it onto
the actual matrix.

voi d DrawPi xel Area(matrix[][], int xDst, int yDst, int w, int h,
int xSrc, int ySrc)

Explanation:

= matrix[] is a 2-dimensional array of colors that holds the source for DrawPixelArea. Use GetPixelArea as

described above to retrieve the data.

» xDst, yDst describe the destination area. The default values are 0.
This allows you to draw the array onto the default position of your virtual matrix or an individual position.
If the source array is larger than your target destination allows, it will be reduced to fit the size of the virtual

matrix.

» w, hdescribe the width and height of the render area. The default values are -1.
A value of -1 means that the whole width or height of the given array will be copied to the virtual matrix (the

complete array).

= XxSrc¢, ySrc describe the source area. The default values are 0.
DrawPixelArea can use and render the complete background matrix that was retrieved with GetPixelArea. Or it

can only access and render a certain part of it.
» In order to draw the whole matrix it is possible to call:

color matrix[][];
Dr awPi xel Area(matri x) ;

= Summary: DrawPixelArea can access the background matrix that was created with GetPixelArea. With
DrawPixelArea you can render the complete array or only parts of it onto your virtual matrix. The array can be

drawn at the default or an individual position.
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» (For the drawing operation, it is assumed that the array describes a rectangular area in which every single line

has the same number of columns.)

Example

DrawPixelArea

The first example for the MAS Script Effect will simply draw a small, red square in the upper left corner of the matrix

with a green center. The colors drawn are defined in the array variable matrix[][]in InitEffect.

@cri pt nane="";
@ut hor="";
@ersion="";
@lescription="";

color matrix[][];

void I nitEffect()

{
mat ri x[ 0] [ 0] =RED;
mat ri x[ 0] [ 1] =RED;
mat ri x[ 0] [ 2] =RED;
mat ri x[ 0] [ 3] =RED;
mat ri x[ 1] [ 0] =RED;
mat ri x[ 1] [ 1] =GREEN,
mat ri x[ 1] [ 2] =GREEN;
mat ri x[ 1] [ 3] =RED;
mat ri x[ 2] [ 0] =RED;
mat ri x[ 2] [ 1] =GREEN,
mat ri x[ 2] [ 2] =GREEN,
mat ri x[ 2] [ 3] =RED;
mat ri x[ 3] [ 0] =RED;
mat ri x[ 3] [ 1] =RED;
mat ri x[ 3] [ 2] =RED;
mat ri x[ 3] [ 3] =RED;

}

voi d Render Ef fect ()

{
DrawPi xel Area(matrix, 0, 0, -1, -1, 0, 0);

}
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2.2.1.7 'PixelTranspose’

Introduction

PixelTranspose is a technic to transpose (move) pixels from their origin/source (srcX and srcY coordinate) to a new

destination. Three (or four) steps are necessary to perform a pixel transposition.

1. Creating the pixel transpose table which holds the information for each pixel that should be moved.
2. Setting or adding the information (source and destination coordinates) for each of those pixels to the table.
3. Executing the pixel transposition.

4, Releasing the pixel transpose table.

1. Creating The Pixel Transpose Table
voi d CreatePi xel TransposeTabl e(int size, int growsize)
The parameter size describes the amount of pixels in the table. The second parameter growsize describes the size

that will be used to grow the table by using AddPixelTransposeEntry if the predefined size of PixelTransposeTable is

reached. It is not necessarily required to use the second parameter because the growsize is set to 128 by default.

2. Setting Or Adding Information

voi d Set Pi xel TransposeEntry(int idx, int srcX, int srcY, int destX, int destY)
Using SetPixelTransposeEntry requires 5 parameters. The first parameter idx defines the index of the predefined
table. This index count starts with zero and has to be lower than the size value of CreatePixelTransposeTable(int size,

int growsize). The second and third parameter, srcX and srcY, describe the source coordinate and the fourth and fifth

parameter, destX and destY, set the destination coordinates.

voi d AddPi xel TransposeEntry(int srcX, int srcY, int destX, int destY)
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Using AddPixelTransposeEntry requires only 4 parameters, i.e. the source and destination coordinates. The function
validates if an entry already exists. If this is not the case, the function adds the entry to the end of the pixel transpose
table. If the predefined size in CreatePixelTransposeTable(int size, int growsize) is then exceeded, the table

automatically grows by the size defined with growsize.

The execution of SetPixelTransposeEntry is performed much faster than that of AddPixelTransposeEntry.

3. Executing The Pixel Transposition

voi d Execut ePi xel Transpose(int clear)

Using this function executes all pixel transpositions that are defined in the pixel transpose table. The clear parameter
defines how the part of the matrix is handled which is not defined as destination. If the clear parameter is set to
CLEAR, the part will be erased using black. Otherwise, if this parameter is set to NOCLEAR, the color values will be

left like they were before.

4. Releasing The Pixel Transpose Table

voi d Rel easePi xel TransposeTabl e()

Using this function releases the created transpose table. That means, that the reserved memory is made available

again.

Examples

The following 3 examples will rotate the Main Output using the pixel transpose technique. Please note that this only
works on quadratic matrices. Just use the SCE Color Gradient effect and insert the following source code into the Main

Output Macro. The differences will be easily visible.

Clockwise Rotation
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As an Main Output Macro, this macro rotates the output 90° clockwise.

@cript nane="Qut put Rotation";

@ut hor ="i noage";

@ersion="2.9";

@lescription="Rotates the nmain output"”;

int Init=0;

void InitEffect()

{

int w= GetMatrixWdth();
int h = GetMatrixHeight();
I nit=0;

i f(w==h) //this exanple runs only on quadratic matrices
{
int idx = 0;

Cr eat ePi xel TransposeTabl e(wh); //nmake a table with wth entities

for(int y=0;y<h;y++)

{
for(int x=0; x<w; X++)
{
Set Pi xel TransposeEntry(idx, x,y, h-y-1,x); //rotate cl ockw se
i dx++;
}
}

Init=1; //init ready, can use ExecutePi xel Transpose()

el se

{
WiteText("This script runs only on quadratic matrices,");
WiteText("but your matrix is "+(string)w"x"+(string)h);

}
}

voi d PreRender Ef f ect ()

{
}

voi d Post Render Ef f ect ()
{
i f(lnit==1)
Execut ePi xel Transpose(CLEAR); //execute to transpose all pixels
/land to clear all non-transposed pixels

}

voi d Matri xSi zeChanged()

{

Rel easePi xel TransposeTabl e(); //release the old transpose table if existent
InitEffect();

}
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Counter-Clockwise Rotation

As a Main Output Macro, this macro rotates the Main Output by 90° counter-clockwise.

@cri pt nane="Qut put Rotation";

@ut hor ="i noage";

@ersion="2.9";

@lescription="Rotates the nain output";

int Init=0;

void InitEffect()

{

int w= GetMatrixWdth();
int h = GetMatrixHeight();
| ni t=0;

if(w==h) //this exanple runs only on quadratic matrices

{
int idx = 0;
Cr eat ePi xel TransposeTabl e(wh); //nmake a table with wwh entities

for(int y=0;y<h;y++)

{
for(int x=0; x<w, x++)
{
Set Pi xel TransposeEntry(idx, x,y,y,wx-1); //rotate counter-cl ockw se
i dx++;
}
}

Init=1; //init ready, can use ExecutePi xel Transpose()

el se

{

WiteText("This script runs only on quadratic matrices,");
WiteText("but your matrix is "+(string)w"x"+(string)h);

}
}

voi d PreRender Ef f ect ()

{
}

voi d Post Render Ef f ect ()
{
if(lnit==1)
Execut ePi xel Transpose(CLEAR); //execute to transpose all pixels
//and to clear all non-transposed pixels

}
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voi d Matri xSi zeChanged()
{

Rel easePi xel TransposeTabl e(); //release the old transpose table if existent
InitEffect();

}

Mirror Diagonally

As an Main Output Macro, use a SCE Color Gradient from bottom left to top right for example to see the result.

@cript nane="Qut put Rotati on";

@ut hor ="i noage";

@ersion="2.9";

@escription="Rotates the nain output"”;

int Init=0;

void InitEffect()

{

int w= GethMatrixWdth();
int h = GetMatrixHei ght();
| ni t=0;

if(w==h) //this exanple runs only on quadratic matrices
{
int idx = 0;
Cr eat ePi xel TransposeTabl e(w*h); //nmake a table with wth entities

for(int y=0;y<h;y++)

{
for(int x=0;x<w, x++)
{
Set Pi xel TransposeEntry(idx, x,y,y,Xx); //mrror diagonally
i dx++;
}
}

Init=1; //init ready, can use ExecutePi xel Transpose()

el se

{
WiteText("This script runs only on quadratic matrices,");
WiteText("but your matrix is "+(string)wt"x"+(string)h);

}
}

voi d PreRender Ef f ect ()

{
}
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voi d Post Render Ef f ect ()

{
if(lnit==1)
Execut ePi xel Transpose(CLEAR); //execute to transpose all pixels
//and to clear all non-transposed pixels

}

voi d Matri xSi zeChanged()
{

Rel easePi xel TransposeTabl e(); //release the old transpose table if existent
InitEffect();

}

2.2,.1.8 'SetPixel

Functionality

SetPixel functions offer the possibility to change the color of pixels. You can either specify a certain color or use

grayscale. The following examples use only some of the functions that are available.

Examples

SetPixel

To test this script, please use the MAS Script Effect.

This sample paints red pixels onto the complete matrix with different brightness values.

@criptnane="Set Pi xel test, use with MAS Script Effect”;
@ut hor="";

@ersion="";

@lescription="";

col or col;
int maxX maxy, X, Y;
void InitEffect()

{
maxX=Cet Mat ri xW dt h() ;
maxY=Cet Mat ri xHei ght () ;
}
voi d Render Ef fect ()
{

col . r=randomn( 0, 255) ;
x=r andom( 0, maxX- 1) ;
y=random( O, maxY-1);
Set Pi xel (col , x,Yy);
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}

voi d Matri xSi zeChanged()
{

}

InitEffect();

SetPixel3D

To test this script, please use the MAS Script Effect.

This sample paints golden pixels onto the complete matrix. Please use a 3D matrix.

@criptname="Set Pi xel 3D test, use with MAS script effect";
@ut hor="";

@ersion="";

@escription="";

int maxX, maxyY, maxz, x, Yy, z;

void InitEffect()

{
maxX=Cet Mat ri xW dt h() ;
maxY=Cet Mat ri xHei ght () ;
maxZ=Cet Mat ri xDept h() ;
}
voi d RenderEffect()
{
Cear();
x=r andon( 0, maxX- 1) ;
y=random( 0, maxY-1);
z=r andon( 0, maxz- 1) ;
Set Pi xel 3D( GALD, X, Y, 2);
}
voi d Matri xSi zeChanged()
{
InitEffect();
}

SetPixel - Filling The Matrix

To test this script, please use the MAS Script Effect.
This sample fills every pixel of every row of the matrix with the color white from left to right until the complete matrix
is covered. Every second iteration black is used instead of white.

@cri pt nane="Set Pi xel Sanpl e";

@ut hor ="i noage";

@ersi on="MADRI X 2.13";
@escription="a sinple setpixel exanple to fill the matrix";
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int x,y,c;
col or col;

void InitEffect()

{
x=0;
y=0;
c=0;
col =VWH TE;
}
voi d Render Ef fect ()
{
Set Pi xel (col , x,Yy);
X++;
if(x>=CGetMatrixWdth())
{
x=0;
y++;
i f(y>=CGetMatrixHei ght())
{
y=0;
C++;
i f(c92==0)
col =VH TE;
el se
col =BLACK;
}
}
}
voi d Matri xSi zeChanged()
{
InitEffect();
}

SetPixelGrayscale (MAS Script)

To test this script, please use the MAS Script effect.

@criptnane="sanpl e of grayscale for a single pixel";
@ut hor="";

@ersion="";

@escription="";

int XY,

void InitEffect()

{
X=Cet Mat ri xHei ght () ;
Y=Cet Mat ri xW dt h() ;

Cl ear (BLUE) ;
}
voi d RenderEf fect ()
{

www.madrix.com /1106



MADRIX 3 Script Help and Manual Version 2.15.

[Part B] MADRIX Script (Introduction)

for(int i=0;i<X & i<Y;i++)

Set Pi xel Grayscale(i,i); // line fromtop left to bottomright

Set Pi xel Gayscale(X-i-1,i); // line fromtop ri

// to render the conplete matrix in grayscale,
/1 offers higher performance:
!/l Gayscale();

}
voi d Matri xSi zeChanged()
{
InitEffect();
}

SetPixelGrayscale (Macro)

To test this script, you can use the Main Output Macro.

ght to bottom|eft

the grayscal e() comrand

But first, please select for example the SCE Color Scroll effect in Storage Left or Right and display the effect on the

output.

@criptnane="sanpl e of grayscale for single pixel";
@ut hor="";

@ersion="";

@escription="";

int XY,

void InitEffect()

{
X=Get Matri xWdt h();
Y=Get Mat ri xHei ght () ;

ght to bottomleft

ght to bottomleft

}
voi d PreRender Ef f ect ()
{
}
voi d Post Render Ef f ect ()
{
i f(X>Y)// width larger than height
{
for(int i=0;i<Y;i++)
{
Set Pi xel Grayscale(i,i); // line fromtop left to bottomright
Set Pi xel Grayscale(i,Y-i-1); // line fromtop ri
}
}
else // height larger than wdth
{
for(int i=0;i<X1i++)
{
Set Pi xel Grayscale(i,i); // line fromtop left to bottomright
Set Pi xel Grayscale(X-i-1,i); // line fromtop ri
}
}
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[/l to render the conplete matrix in grayscale, the Gayscal e() comrand
/1 offers higher perfornance
/1 Gayscal e();

}

2.2.1.9 Draw Shapes

Overview

= MADRIX Script provides powerful functions to draw shapes onto the matrix.
= You can either use absolute pixel values or you can use relative vector values.

= These functions can be used for 2D as well as 3D.

Functions

= voi d DrawPi xel Shape(col or col, int shape, int x, int y, int z,
int w, int h, int d, int lineWdth, int drawvbde, int |ookAt Type)

color col - Is of the data type structure and defines a color for the shape. »

int shape -Is of the file data integer and defines the type of shape. See for a list of Shape Type constants.
int x - Is of the file data integer and defines the X-coordinate (left).

int y - Is of the file data integer and defines the Y-coordinate (top).

int z - Is of the file data integer and defines the Z-coordinate (front).

int w - Is of the file data integer and defines the width of the shape.

int h - Is of the file data integer and defines the height of the shape.

int d - Is of the file data integer and defines the depth of the shape.

int ineWidth - Is of the data type integer and defines the width of the shapes' border. This is not supported by all

shapes. See for a list of supported shapes and modes.

int drawMode - Is of the data type integer and defines the Draw Mode. See for a list of Draw Mode
constants.

int lookAtType - Is of the data type integer and defines the Look-At Type. See for a list of Look-At Type
Constants.

= voi d DrawVect or Shape(col or col, int shape, float x, float y, float z,

float w, float h, float d, int |ineWdth, int drawwbde, int | ookAtType)
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color col - Is of the data type structure and defines a color for the shape. »

int shape -Is of the file data integer and defines the type of shape. See for a list of Shape Type constants.
float x - Is of the file data float and defines the X-coordinate relative to the matrix size (left).

float y - Is of the file data float and defines the Y-coordinate relative to the matrix size (top).

float z - Is of the file data float and defines the Z-coordinate relative to the matrix size (front).

float w - Is of the file data float and defines the width of the shape relative to the matrix size.

float h - Is of the file data float and defines the height of the shape relative to the matrix size.

float d - Is of the file data float and defines the depth of the shape relative to the matrix size.

int lineWidth -Is of the data type integer and defines the width of the shapes' border. This is not supported by all

shapes. See for a list of supported shapes and modes.

int drawMode - Is of the data type integer and defines the Draw Mode. See for a list of Draw Mode
constants.

int lookAtType - Is of the data type integer and defines the Look-At Type. See for a list of Look-At Type
Constants.

- Valid values for relative float values range from 0.0 to 1.0.
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Shape Type Constants

Descriptio Supported Draw Modes lineWidth
n
int DRAWSHAPE RECTANGLE Renders a int DRAWVODE_ LI NE Only supported
rectangle. int DRAWMODE FACE with int
B DRAWVODE LI N
E
int DRAWSHAPE _SQUARE Renders a int DRAWVODE_ LI NE Only supported
square. int DRAWMODE _FACE with int
B DRAWVMODE LI N
E
int DRAWSHAPE_Cl RCLE Renders a int DRAWMODE LI NE Only supported
circle. int DRAWVODE FACE with int
B DRAWMODE LI N
E
int DRAWSHAPE_ELLI PSE Renders a int DRAWMODE_ LI NE Only supported
ellipse. int DRAWMODE _FACE with int
- DRAWMODE_LI N
E
int DRAWSHAPE _CROSS Renders a int DRAWMODE_ LI NE Not Supported
Cross.
int DRAWSHAPE_STAR Renders a int DRAWMODE_ LI NE Not Supported
star.
int DRAWSHAPE_DI AMOND Renders a int DRAWMODE_ LI NE Only supported
diamond. int DRAWVMODE FACE with int
- DRAWVMODE LI N
E
int DRAWSHAPE SPHERE Renders a int DRAWMODE_ LI NE Only supported
sphere. int DRAWMODE _FACE with int
int DRAWMODE_ VOL UVE DRAWVCDE_FAC
E
int DRAWSHAPE _OCTAHEDRON Renders a int DRAWVODE_ LI NE Only supported
octahedro int DRAWMODE _FACE with int
n. int DRAWVODE_ VOLUVE DRAWVODE_FAC
E
int DRAWSHAPE_BOX Renders a int DRAWMODE_LI NE Only supported
box. int DRAWMODE_FACE with int
int DRAWVODE_VOLUVE DRAWMODE_FAC
E
int DRAWSHAPE CUBE Renders a int DRAWMODE LI NE Only supported
cube. int DRAWMODE_FACE with int

int DRAWMODE_VOL UVE

DRAWVODE_FAC
E
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Draw Mode Constants

Constant Description
int DRAWVMODE_ LI NE Renders the outline of the shape (2D and 3D: Outlined).
int DRAWVMODE _FACE Renders the outer surfaces (2D: Filled , 3D : Unfilled).
int DRAWMODE_VOLUMVE Renders the complete inner and outer shape (3D: Filled).

Look-At Type Constants

Constant Description
int LOOKAT_FRONT Applies no rotation and allows you to look directly at the shape (Front
int LOOKAT_BACK Represents a rotation of 180° around the Y-axis (Back).
int LOOKAT_LEFT Represents a rotation of -90° around the Y-axis ( Left).
int LOOKAT_RI GHT Represents a rotation of 90° around the Y-axis (Right).
int LOOKAT_TOP Represents a rotation of -90° around the X-axis (Top).
int LOOKAT_BOTTOM Represents a rotation of 90° around the X-axis (Bottom).

2.2,1.10 Render Shapes

Overview

» MADRIX Script provides powerful functions to render shapes onto the matrix.

= These functions can be used for 2D as well as 3D.

Functions

= voi d Render Shape(struct color, int shapeType, float positionX, float positionY, float po
float sizeX, float sizeY, float sizeZ, struct shape, int unitType)
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struct color - Is of the data type structure and defines a color for the shape. »

int shapeType - Is of the data type integer and defines the type of shape. See for a list of Shape Type

constants.

float positionX -Is of the data type float and defines the X-coordinate (left) in percent of the matrix size.
float positionY -Is of the data type float and defines the Y-coordinate (top) in percent of the matrix size.
float positionZ - Is of the data type float and defines the Z-coordinate (front) in percent of the matrix size.
float sizeX - Is of the data type float and defines the width of the shape in percent of the matrix size.

float sizeY -1Is of the data type float and defines the width of the shape in percent of the matrix size.

float sizeZ - Is of the data type float and defines the width of the shape in percent of the matrix size.

struct shape - Is of the data type structure and defines various settings for the shape. This structure needs be
initialized first. Initialize it with its default settings by using the function GetDefaultShape(). Define settings as

required. See for more information.

int unitType - Is of the data type integer and defines the usage of units. See for a list of Unit Type

constants.

Shape Type Constants

Constant Description

int SHAPE_TYPE_LI NE

Sets the Shape Type to

Line.

int SHAPE_TYPE_CURVE

Sets the Shape Type to

Curve.

int SHAPE_TYPE_FI LLED

Sets the Shape Type to

Filled.

int SHAPE_TYPE_RECTANGLE_OUTLI NED

Sets the Shape Type to
Outlined.

Rectangle

int SHAPE_TYPE_RECTANGLE_OUTLI NED_| MPLCODE

Sets the Shape Type to
Outlined Implode.

Rectangle

int SHAPE_TYPE_RECTANGLE_OUTLI NED_EXPL CDE

Sets the Shape Type to
Outlined Explode.

Rectangle

int SHAPE_TYPE_RECTANGLE_FI LLED

Sets the Shape Type to

Rectangle Filled.

int SHAPE_TYPE_RECTANGLE_FI LLED_| MPLCODE

Sets the Shape Type to
Implode.

Rectangle Filled

int SHAPE_TYPE_RECTANGLE_FI LLED_EXPLODE

Sets the Shape Type to
Explode.

Rectangle Filled

int SHAPE_TYPE_SQUARE_OUTLI NED

Sets the Shape Type to

Square Outlined

int SHAPE_TYPE_SQUARE_OUTLI NED_| MPLODE

Sets the Shape Type to
Implode.

Square Outlined
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Constant Description

int SHAPE_TYPE_SQUARE_COUTLI NED_EXPLODE Sets the Shape Type to Square Outlined
Explode.

int SHAPE_TYPE_SQUARE_FI LLED Sets the Shape Type to Square Filled.

int SHAPE_TYPE_SQUARE_FI LLED | MPLODE Sets the Shape Type to Square Filled
Implode.

int SHAPE_TYPE_SQUARE_FI LLED EXPLODE Sets the Shape Type to Square Filled
Explode.

int SHAPE_TYPE_ELLI PSE_OUTLI NED Sets the Shape Type to Ellipse Outlined.

int SHAPE_TYPE_ELLI PSE_OUTLI NED_| MPLODE Sets the Shape Type to Ellipse Outlined
Implode.

int SHAPE_TYPE_ELLI PSE_OUTLI NED_EXPL ODE Sets the Shape Type to Ellipse Outlined
Explode.

int SHAPE_TYPE_ELLI PSE_FI LLED Sets the Shape Type to Ellipse Filled.

int SHAPE_TYPE_ELLI PSE_FI LLED_| MPLODE Sets the Shape Type to Ellipse Filled
Implode.

int SHAPE_TYPE_ELLI PSE_FI LLED_EXPLODE Sets the Shape Type to Ellipse Filled
Explode.

int SHAPE_TYPE_CI RCLE_OUTLI NED Sets the Shape Type to Circle Outlined.

int SHAPE_TYPE_CI RCLE_CQOUTLI NED_| MPLODE Sets the Shape Type to Circle Outlined
Implode.

int SHAPE_TYPE_CI RCLE_QOUTLI NED_EXPLODE Sets the Shape Type to Circle Outlined
Explode.

int SHAPE_TYPE_ClI RCLE_FI LLED Sets the Shape Type to Circle Filled.

int SHAPE_TYPE_CI RCLE_FI LLED_| MPLODE Sets the Shape Type to Circle Filled
Implode.

int SHAPE_TYPE_ClI RCLE_FI LLED EXPLODE Sets the Shape Type to Circle Filled
Explode.

int SHAPE_TYPE_DI AMOND_QOUTLI NED Sets the Shape Type to Diamond
Outlined.

int SHAPE_TYPE_DI AMOND_OUTLI NED_| MPLODE Sets the Shape Type to Diamond
Outlined Implode.

int SHAPE_TYPE_DI AMOND_OUTLI NED_EXPLODE Sets the Shape Type to Diamond
Outlined Explode.

int SHAPE_TYPE_DI AMOND_FI LLED Sets the Shape Type to Diamond Filled.

int SHAPE_TYPE_DI AMOND_FI LLED_| MPLODE Sets the Shape Type to Diamond Filled
Implode.

int SHAPE_TYPE_DI AMOND_FI LLED_EXPL ODE Sets the Shape Type to Diamond Filled
Explode.

int SHAPE_TYPE_HEART_OUTLI NED Sets the Shape Type to Heart Outlined.

int SHAPE_TYPE_HEART_OUTLI NED_I MPLCODE Sets the Shape Type to Heart Outlined
Implode.
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Constant

Description

int SHAPE_TYPE_HEART_OUTLI| NED_EXPLODE

Sets the Shape Type to Heart Outlined
Explode.

int SHAPE_TYPE_HEART _FI LLED

Sets the Shape Type to Heart Filled.

int SHAPE_TYPE_HEART_FI LLED | MPLODE

Sets the Shape Type to Heart Filled
Implode.

int SHAPE_TYPE_HEART _FI LLED _EXPLODE

Sets the Shape Type to Heart Filled
Explode.

int SHAPE_TYPE_CROSS_OUTLI NED

Sets the Shape Type to Cross Outlined.

int SHAPE_TYPE_CROSS_OUTLI NED_| MPLODE

Sets the Shape Type to Cross Outlined
Implode.

int SHAPE_TYPE_CROSS_OUTLI NED_EXPLODE

Sets the Shape Type to Cross Outlined
Explode.

int SHAPE_TYPE_CROSS_FI LLED

Sets the Shape Type to Cross Filled.

int SHAPE_TYPE_CROSS_FI LLED | MPLODE

Sets the Shape Type to Cross Filled
Implode.

int SHAPE_TYPE_CROSS_FI LLED_EXPLODE

Sets the Shape Type to Cross Filled
Explode.

int SHAPE_TYPE_CROSS_STRAI GHT_OUTLI NED

Sets the Shape Type to Cross Straight
Outlined.

int SHAPE_TYPE_CROSS_STRAI GHT_OUTLI NED_| MPLODE

Sets the Shape Type to Cross Straight
Outlined Implode.

int SHAPE_TYPE_CROSS_STRAI GHT_OUTLI NED_EXPLODE

Sets the Shape Type to Cross Straight
Outlined Explode.

int SHAPE_TYPE_CROSS_STRAI GHT_FI LLED

Sets the Shape Type to Cross Straight
Filled.

int SHAPE_TYPE_CROSS_STRAI GHT_FI LLED_| MPLODE

Sets the Shape Type to Cross Straight
Filled Implode.

int SHAPE_TYPE_CROSS_STRAI GHT_FI LLED_EXPLODE

Sets the Shape Type to Cross Straight
Filled Explode.

int SHAPE_TYPE_STAR_OUTLI NED

Sets the Shape Type to Star Outlined.

int SHAPE_TYPE_STAR_OUTLI NED_| MPLODE

Sets the Shape Type to Star Outlined
Implode.

int SHAPE_TYPE_STAR_OUTLI NED_EXPLODE

Sets the Shape Type to Star Outlined
Explode.

int SHAPE_TYPE_STAR_FI LLED

Sets the Shape Type to Star Filled.

int SHAPE_TYPE_STAR_FI LLED_| MPLODE

Sets the Shape Type to Star Filled
Implode.

int SHAPE_TYPE_STAR_FI LLED_EXPLODE

Sets the Shape Type to Star Filled
Explode.

int SHAPE_TYPE_TRI ANGLE_OUTLI NED

Sets the Shape Type to Triangle
Outlined.

int SHAPE_TYPE_TRI ANGLE_OUTLI NED_| MPLODE

Sets the Shape Type to Triangle
Outlined Implode.

www.madrix.com

/1114




MADRIX 3 Script Help and Manual Version 2.15.

[Part B] MADRIX Script (Introduction)

Constant

Description

int SHAPE_TYPE_TRI ANGLE_OUTLI NED_EXPLODE

Sets the Shape Type to Triangle
Outlined Explode.

int SHAPE_TYPE_TRI ANGLE_FI LLED

Sets the Shape Type to Triangle Filled.

int SHAPE_TYPE_TRI ANGLE_FI LLED_| MPLODE

Sets the Shape Type to Triangle Filled
Implode.

int SHAPE_TYPE_TRI ANGLE_FI LLED_ EXPLODE

Sets the Shape Type to Triangle Filled
Explode.

int SHAPE_TYPE_BOX_OUTLI NED

Sets the Shape Type to 3D Box Outlined

int SHAPE_TYPE_BOX_OUTLI NED_| MPLODE

Sets the Shape Type to 3D Box Outlined
Implode.

int SHAPE_TYPE_BOX_OUTLI NED_EXPLODE

Sets the Shape Type to 3D Box Outlined
Explode.

int SHAPE_TYPE_BOX_UNFI LLED

Sets the Shape Type to 3D Box Unfilled.

int SHAPE_TYPE_BOX_UNFI LLED | MPLODE

Sets the Shape Type to 3D Box Unfilled
Implode.

int SHAPE_TYPE_BOX_UNFI LLED _EXPLODE

Sets the Shape Type to 3D Box Unfilled
Explode.

int SHAPE_TYPE_BOX_FI LLED

Sets the Shape Type to 3D Box Filled.

int SHAPE_TYPE_BOX_FI LLED_| MPLODE

Sets the Shape Type to 3D Box Filled
Implode.

int SHAPE_TYPE_BOX_FI LLED_EXPLODE

Sets the Shape Type to 3D Box Filled
Explode.

int SHAPE_TYPE_CUBE_CQOUTLI NED

Sets the Shape Type to 3D Cube
Outlined.

int SHAPE_TYPE_CUBE_OUTLI NED_| MPLODE

Sets the Shape Type to 3D Cube
Outlined Implode.

int SHAPE_TYPE_CUBE_OUTLI| NED_EXPLODE

Sets the Shape Type to 3D Cube
Outlined Explode.

int SHAPE_TYPE_CUBE_UNFI LLED

Sets the Shape Type to 3D Cube Unfilled

int SHAPE_TYPE_CUBE_UNFI LLED | MPLODE

Sets the Shape Type to 3D Cube Unfilled
Implode.

int SHAPE_TYPE_CUBE_UNFI LLED EXPLODE

Sets the Shape Type to 3D Cube Unfilled
Explode.

int SHAPE_TYPE_CUBE_FI LLED

Sets the Shape Type to 3D Cube Filled.

int SHAPE_TYPE_CUBE_FI LLED_| MPLODE

Sets the Shape Type to 3D Cube Filled
Implode.

int SHAPE_TYPE_CUBE_FI LLED_EXPLODE

Sets the Shape Type to 3D Cube Filled
Explode.

int SHAPE_TYPE_SPHERE_UNFI LLED

Sets the Shape Type to 3D Sphere
Unfilled.
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Constant

Description

int SHAPE_TYPE_SPHERE_UNFI LLED_| MPLODE

Sets the Shape Type to 3D Sphere
Unfilled Implode.

int SHAPE_TYPE_SPHERE_UNFI LLED EXPLODE

Sets the Shape Type to 3D Sphere
Unfilled Explode.

int SHAPE_TYPE_SPHERE_FI LLED

Sets the Shape Type to 3D Sphere Filled.

int SHAPE_TYPE_SPHERE_FI LLED | MPLODE

Sets the Shape Type to 3D Sphere Filled
Implode.

int SHAPE_TYPE_SPHERE_FI LLED EXPLODE

Sets the Shape Type to 3D Sphere Filled
Explode.

int SHAPE_TYPE_ELLI PSO D_UNFI LLED

Sets the Shape Type to 3D Ellipsoid
Unfilled.

int SHAPE_TYPE_ELLI PSOl D_UNFI LLED_| MPLODE

Sets the Shape Type to 3D Ellipsoid
Unfilled Implode.

int SHAPE_TYPE_ELLI PSO D_UNFI LLED_EXPL CDE

Sets the Shape Type to 3D Ellipsoid
Unfilled Explode.

int SHAPE_TYPE_ELLI PSO D_FI LLED

Sets the Shape Type to 3D Ellipsoid
Filled.

int SHAPE_TYPE_ELLI PSO D_FI LLED_| MPLODE

Sets the Shape Type to 3D Ellipsoid
Filled Implode.

int SHAPE_TYPE_ELLI PSOl D_FI LLED_EXPLODE

Sets the Shape Type to 3D Ellipsoid
Filled Explode.

int SHAPE_TYPE_OCTAHEDRON_UNFI LLED

Sets the Shape Type to 3D Octahedron
Unfilled.

int SHAPE_TYPE_OCTAHEDRON_UNFI LLED | MPLODE

Sets the Shape Type to 3D Octahedron
Unfilled Implode.

int SHAPE_TYPE_OCTAHEDRON_UNFI LLED EXPLODE

Sets the Shape Type to 3D Octahedron
Unfilled Explode.

int SHAPE_TYPE_OCTAHEDRON_FI LLED

Sets the Shape Type to 3D Octahedron
Filled.

int SHAPE_TYPE_OCTAHEDRON_FI LLED | MPLODE

Sets the Shape Type to 3D Octahedron
Filled Implode.

int SHAPE_TYPE_OCTAHEDRON_FI LLED EXPLODE

Sets the Shape Type to 3D Octahedron
Filled Explode.

int SHAPE_TYPE_3D_HEART_UNFI LLED

Sets the Shape Type to 3D Heart
Unfilled.

int SHAPE_TYPE_3D_HEART_UNFI LLED_| MPLODE

Sets the Shape Type to 3D Heart
Unfilled Implode.

int SHAPE_TYPE_3D_HEART_UNFI LLED EXPLODE

Sets the Shape Type to 3D Heart
Unfilled Explode.

int SHAPE_TYPE_3D_HEART_FI LLED

Sets the Shape Type to 3D Heart Filled.

int SHAPE_TYPE_3D_HEART_FI LLED_| MPLODE

Sets the Shape Type to 3D Heart Filled
Implode.

int SHAPE_TYPE_3D_HEART_FI LLED_EXPLODE

Sets the Shape Type to 3D Heart Filled
Explode.
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Constant

Description

int SHAPE_TYPE_3D_STAR_UNFI LLED

Sets the Shape Type to 3D Star Unfilled.

int SHAPE_TYPE_3D_STAR_UNFI LLED_| MPLODE

Sets the Shape Type to 3D Star Unfilled
Implode.

int SHAPE_TYPE_3D_STAR_UNFI LLED_EXPLODE

Sets the Shape Type to 3D Star Unfilled
Explode.

int SHAPE_TYPE_3D_STAR_FI LLED

Sets the Shape Type to 3D Star Filled.

int SHAPE_TYPE_3D_STAR_FI LLED | MPLODE

Sets the Shape Type to 3D Star Filled
Implode.

int SHAPE_TYPE_3D_STAR_FI LLED_EXPLODE

Sets the Shape Type to 3D Star Filled
Explode.

int SHAPE_TYPE_3D_CROSS_UNFI LLED

Sets the Shape Type to 3D Cross
Unfilled.

int SHAPE_TYPE_3D_CROSS_UNFI LLED_| MPLODE

Sets the Shape Type to 3D Cross
Unfilled Implode.

int SHAPE_TYPE_3D_CROSS_UNFI LLED_EXPLODE

Sets the Shape Type to 3D Cross
Unfilled Explode.

int SHAPE_TYPE_3D_CROSS_FI LLED

Sets the Shape Type to 3D Cross Filled.

int SHAPE_TYPE_3D_CROSS_FI LLED | MPLODE

Sets the Shape Type to 3D Cross Filled
Implode.

int SHAPE_TYPE_3D_CROSS_FI LLED_EXPLODE

Sets the Shape Type to 3D Cross Filled
Explode.

int SHAPE_TYPE_3D_CROSS_STRAI GHT_UNFI LLED

Sets the Shape Type to 3D Cross
Straight Unfilled.

int SHAPE_TYPE_3D_CROSS_STRAI GHT_UNFI LLED | MPLODE

Sets the Shape Type to 3D Cross
Straight Unfilled Implode.

int SHAPE_TYPE_3D_CROSS_STRAI GHT_UNFI LLED EXPLODE

Sets the Shape Type to 3D Cross
Straight Unfilled Explode.

int SHAPE_TYPE_3D_CROSS_STRAI GHT_FI LLED

Sets the Shape Type to 3D Cross
Straight Filled.

int SHAPE_TYPE_3D_CROSS_STRAI GHT_FI LLED | MPLODE

Sets the Shape Type to 3D Cross
Straight Filled Implode.

int SHAPE_TYPE_3D_CROSS_STRAI GHT_FI LLED_EXPLODE

Sets the Shape Type to 3D Cross
Straight Filled Explode.

int SHAPE_TYPE_PYRAM D_UNFI LLED

Sets the Shape Type to 3D Pyramid
Unfilled.

int SHAPE_TYPE_PYRAM D_UNFI LLED_| MPLCODE

Sets the Shape Type to 3D Pyramid
Unfilled Implode.

int SHAPE_TYPE_PYRAM D_UNFI LLED_EXPLCDE

Sets the Shape Type to 3D Pyramid
Unfilled Explode.

int SHAPE_TYPE_PYRAM D_FI LLED

Sets the Shape Type to 3D Pyramid
Filled.

int SHAPE_TYPE_PYRAM D_FI LLED | MPLODE

Sets the Shape Type to 3D Pyramid
Filled Implode.

www.madrix.com

11117




MADRIX 3 Script Help and Manual Version 2.15. [Part B] MADRIX Script (Introduction)

Constant Description

int SHAPE_TYPE_PYRAM D_FI LLED_EXPLCODE Sets the Shape Type to 3D Pyramid
Filled Explode.

int SHAPE_TYPE_TEXT Sets the Shape Type to Text.

int SHAPE_TYPE_WAVE_LI NEAR Sets the Shape Type to Wave Linear.

int SHAPE_TYPE_WAVE_RADAR Sets the Shape Type to Wave Radar.

int SHAPE_TYPE_WAVE_HELI X Sets the Shape Type to Wave Helix.

int SHAPE_TYPE_WAVE_CI RCLE Sets the Shape Type to Wave Circle.

int SHAPE_TYPE_WAVE_SQUARE Sets the Shape Type to Wave Square.

int SHAPE_TYPE_WAVE_ DI AMOND Sets the Shape Type to Wave Diamond.

int SHAPE_TYPE_WAVE_SPHERE Sets the Shape Type to Wave Sphere.

int SHAPE_TYPE_WAVE_CUBE Sets the Shape Type to Wave Cube.

int SHAPE_TYPE_WAVE_OCTAHEDRON Sets the Shape Type to Wave
Octahedron.

int SHAPE_TYPE_RANDOM Selects an available Shape Type for each
shape randomly. Sets the Shape Type to
Random.

int SHAPE_TYPE_RANDOM STATI C Sets the Shape Type to Random Static.

int SHAPE_TYPE_RANDOM | MPLODE Sets the Shape Type to Random
Implode.

int SHAPE_TYPE_RANDOM_EXPLODE Sets the Shape Type to Random
Explode.

int SHAPE_TYPE_RANDOM_OUTLI NED Sets the Shape Type to Random
Outlined.

int SHAPE _TYPE_RANDOM OUTLI NED_STATI C Sets the Shape Type to Random
Outlined Static.

int SHAPE_TYPE_RANDOM _COUTLI NED_| MPLODE Sets the Shape Type to Random
Outlined Implode.

int SHAPE_TYPE_RANDOM_COUTLI NED_EXPLODE Sets the Shape Type to Random
Outlined Explode.

int SHAPE_TYPE_RANDOM_UNFI LLED Sets the Shape Type to Random Unfilled

int SHAPE_TYPE_RANDOM _UNFI LLED _STATI C Sets the Shape Type to Random Unfilled
Static.

int SHAPE_TYPE_RANDOM UNFI LLED | MPLODE Sets the Shape Type to Random Unfilled
Implode.

int SHAPE_TYPE_RANDOM_UNFI LLED EXPLODE Sets the Shape Type to Random Unfilled
Explode.

int SHAPE_TYPE_RANDOM FI LLED Sets the Shape Type to Random Filled.

int SHAPE_TYPE_RANDOM FI LLED_STATI C Sets the Shape Type to Random Filled
Static.
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Constant

Description

int SHAPE_TYPE_RANDOM FI LLED | MPLODE

Sets the Shape Type to Random Filled

Implode.

int SHAPE_TYPE_RANDOM FI LLED EXPLODE

Sets the Shape Type to Random Filled

Explode.

int SHAPE_TYPE_2D_RANDOM

Sets the Shape Type to 2D Random.

int SHAPE_TYPE_2D_RANDOM STATI C

Sets the Shape Type to 2D Random
Static.

int SHAPE_TYPE_2D_RANDOM | MPLODE

Sets the Shape Type to 2D Random
Implode.

int SHAPE_TYPE_2D_RANDOM EXPL ODE

Sets the Shape Type to 2D Random
Explode.

int SHAPE_TYPE_2D_RANDOM OUTLI NED

Sets the Shape Type to 2D Random
Outlined.

int SHAPE_TYPE_2D_ RANDOM OUTLI NED_STATI C

Sets the Shape Type to 2D Random
Outlined Static.

int SHAPE_TYPE_2D_RANDOM OUTLI NED_| MPLODE

Sets the Shape Type to 2D Random
Outlined Implode.

int SHAPE_TYPE_2D_RANDOM OUTLI NED_EXPLODE

Sets the Shape Type to 2D Random
Outlined Explode.

int SHAPE_TYPE_2D_RANDOM FI LLED

Sets the Shape Type to 2D Random
Filled.

int SHAPE_TYPE_2D RANDOM FI LLED_STATI C

Sets the Shape Type to 2D Random
Filled Static.

int SHAPE_TYPE_2D_RANDOM FI LLED_| MPLODE

Sets the Shape Type to 2D Random
Filled Implode.

int SHAPE_TYPE_2D_RANDOM FI LLED_EXPLODE

Sets the Shape Type to 2D Random
Filled Explode.

int SHAPE_TYPE_3D_RANDOM

Sets the Shape Type to 3D Random.

int SHAPE_TYPE_3D_RANDOM STATI C

Sets the Shape Type to 3D Random
Static.

int SHAPE_TYPE_3D_RANDOM | MPLODE

Sets the Shape Type to 3D Random
Implode.

int SHAPE_TYPE_3D_RANDOM EXPL ODE

Sets the Shape Type to 3D Random
Explode.

int SHAPE_TYPE_3D_RANDOM UNFI LLED

Sets the Shape Type to 3D Random
Unfilled.

int SHAPE_TYPE_3D_RANDOM UNFI LLED_STATI C

Sets the Shape Type to 3D Random
Unfilled Static.

int SHAPE_TYPE_3D_RANDOM UNFI LLED_| MPLODE

Sets the Shape Type to 3D Random
Unfilled Implode.

int SHAPE_TYPE_3D_RANDOM UNFI LLED_EXPLODE

Sets the Shape Type to 3D Random
Unfilled Explode.

int SHAPE_TYPE_3D_RANDOM FI LLED

Sets the Shape Type to 3D Random
Filled.
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Constant

int SHAPE_TYPE_3D_RANDOM FI LLED_STATI C

Description

Sets the Shape Type to 3D Random
Filled Static.

int SHAPE_TYPE_3D_RANDOM FI LLED | MPLODE Sets the Shape Type to 3D Random

Filled Implode.

int SHAPE_TYPE_3D_RANDOM FI LLED_EXPLODE Sets the Shape Type to 3D Random

Filled Explode.

Shape Structure
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shape int renderingMode

int shapeAlignment

int shapeRotation

int blendingMode

int originType

float border

float innerGlow

float outerGlow

int innerGlow Interpolation
int outerGlowInterpolation
float proportion

float diagonalLength

shape stores specific information for shapes.

Valid values for renderingMode are:
RENDERI NG_MODE_EXTENDED

RENDERI NG_MODE_SI MPLE

Valid values for shapeAlignment are:
LOOKAT _FRONT

LOOKAT _BACK
LOOKAT LEFT
LOOKAT_RI GHT
LOOKAT_TOP
LOOKAT_BOTTOM
LOOKAT_RANDOM

Valid values for shapeRotation are:
ROTATI ON_CCW 0

ROTATI ON_CCW 90

ROTATI ON_CCW 180

ROTATI ON_CCW 270

ROTATI ON_CW 0

ROTATI ON_CW 90

ROTATI ON_CW 180

ROTATI ON_CW 270

blendingMode is only available for RENDERING_MODE_EXTENDED.
Valid values are:
BLENDI NG_MODE_NONE

BLENDI NG_MODE_ALPHA

Valid values for originType are:
ORI G N_CENTER

ORI G N_FRONT

ORI G N_BACK

ORI G N_LEFT

ORI G N_RI GHT

ORI G N_TOP

ORI Gl N_BOTTOM

ORI Gl N_TOP_LEFT

ORI Gl N_TOP_RI GHT

ORI Gl N_BOTTOM LEFT

ORI Gl N_BOTTOM RI GHT

ORI Gl N_FRONT_LEFT

ORI Gl N_FRONT_RI GHT

ORI Gl N_BACK_LEFT

ORI G N_BACK_RI GHT

ORI Gl N_FRONT_TOP

ORI Gl N_FRONT_BOTTOM
ORI G N_BACK_TOP

ORI Gl N_BACK_BOTTOM

ORI Gl N_FRONT_TOP_LEFT
ORI Gl N_FRONT_TOP_RI GHT
ORI Gl N_FRONT_BOTTOM LEFT
ORI Gl N_FRONT_BOTTOM RI GHT
ORI Gl N_BACK_TOP_LEFT
ORI Gl N_BACK_TOP_RI GHT
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ORI Gl N_BACK_BOTTOM LEFT
ORI Gl N_BACK_BOTTOM RI GHT

borderis only available for RENDERING_MODE_EXTENDED.
Valid values range from 0.01 to 1.00.

innerGlow is only available for RENDERING_MODE_EXTENDED.
Valid values range from 0.01 to 1.00.

outerGlow is only available for RENDERING_MODE_EXTENDED.
Valid values range from 0.01 to 1.00.

Valid values for innerGlow Interpolation are:

| NTERPOLATI ON_TYPE_LI NEAR

| NTERPOLATI ON_TYPE_EASE_BOUNCE_I N

| NTERPOLATI ON_TYPE_EASE_BOUNCE_OUT

| NTERPOLATI ON_TYPE_EASE_BOUNCE_| NOUT
| NTERPOLATI ON_TYPE_EASE CIRC I N

| NTERPOLATI ON_TYPE_EASE_CI RC_OUT

| NTERPOLATI ON_TYPE_EASE_CI RC_| NOUT

| NTERPOLATI ON_TYPE_EASE_CUBI C_|I N

| NTERPOLATI ON_TYPE_EASE_CuUBI C_OUT

| NTERPOLATI ON_TYPE_EASE_CUBI C_| NOUT
| NTERPOLATI ON_TYPE_EASE_SI NE_I N

| NTERPOLATI ON_TYPE_EASE_SI NE_OUT

| NTERPOLATI ON_TYPE_EASE_SI NE_| NOUT

| NTERPOLATI ON_TYPE_EASE_EXPO I N

| NTERPOLATI ON_TYPE_EASE_EXPO_OUT

| NTERPOLATI ON_TYPE_EASE_EXPO | NOUT

Valid values for outerGlow Interpolation are:
See innerGlow Interpolation

proportion is only available for RENDERING_MODE_EXTENDED
for SHAPE_TYPE_CROSS_STRAIGHT, SHAPE_TYPE_STAR,
SHAPE_TYPE_3D_CROSS_STRAIGHT, and
SHAPE_TYPE_3D_STAR.

Valid values range from 0.01 to 1.00.

diagonalLength is only available for
RENDERING_MODE_EXTENDED and for SHAPE_TYPE_CROSS,
SHAPE_TYPE_STAR, SHAPE_TYPE_3D_CROSS, and
SHAPE_TYPE_3D_STAR.

Valid values range from 0.01 to 1.00.

and

Unit Type Constants
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Constant

Description

int UNI T_TYPE_NORM

Uses normalized values ranging from 0.0 to 1.0. It is the default
parameter.

int UNI T_TYPE_VOXEL

Uses voxel units based on the Matrix Size.

int UNI T_TYPE_PERCENT

Uses percentage values from 0 to 100.

Example

@cri pt nane="Render Shape";
@ut hor="";

@ersi on="MADRI X 3.4";
@lescri pti on="Exanpl e";

color col = WVH TE;

shape shapeProps = Get Def aul t Shape();

float pos_x = 0.
float pos_y
float pos_z
float size_x
float size_y
float size z =

5;
5;
5

0.
0.

0.
0.
1.

o~ ~

int shapeType = SHAPE TYPE Cl RCLE_QUTLI NED;

int unitType = UNI T_TYPE_NORM

void InitEffect()

LOOKAT_FRONT ;

| NTERPCLATI ON_TYPE_LI NEAR;
I NTERPCLATI ON_TYPE_LI NEAR;

pos_x, pos_y, pos_z, size_x, size_y, size_z, shapeProps,

uni t Type) ;

pos_x - 0.25, pos_y - 0.25, pos_z - 0.25, size x, size_.y, size_z,

{
shapePr ops. renderi ngMbde = RENDERI NG_MODE_EXTENDED;
shapePr ops. shapeAl i gnment =
shapePr ops. shapeRot ati on = ROTATI ON_CW 90;
shapePr ops. bl endi ngMbde = BLENDI NG MODE_ALPHA ;
shapeProps. ori gi nType = ORI G N_CENTER,
shapeProps. border = 0. 01;
shapeProps. i nnerd ow = 0.5;
shapeProps. outerd ow = 0. 2;
shapeProps. i nner d ow nt er pol ati on
shapePr ops. out er d ow nt er pol ati on

/I shapePr ops. proportion;
/| shapePr ops. di agonal Lengt h;

}

voi d PreRender Ef f ect ()

{

}

voi d Post Render Ef f ect ()

{
Render Shape(col, shapeType,
Render Shape(col, shapeType,

}
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voi d Matri xSi zeChanged()
{

}

InitEffect();

2.2.2 Sound2Light And Music2Light

MADRIX can analyze audio input for Sound2Light (S2L) or Music2Light (M2L) effects. This data is also available in

MADRIX Script and may be used to create even more advanced effects, controlled by music.

It is necessary to differentiate between music and sound data.

= Sound data refers to data based on the frequency of the given input signal. A common effect based on sound

data is the equalizer (audio spectrum). The volume is also this kind of sound data.

» Music data refers to information known from actual music theory. Therefore, MADRIX identifies musical
parameters, such as tonality, bass, intervals or the current tone (or chord) itself. Using the tone and the tonality

you could see that C Major or d minor are currently played, for example. There are humerous examples.

As is the case with M2L or S2L effects, if a script uses any functionality that needs the audio analysis, the audio
function it is automatically started in MADRIX.
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2.2.2.1 Sound2Light (S2L)

Functionality

As described above, sound data refers mainly to frequency-based data. First of all, the function GetSoundLevel()

retrieves the volume of the audio channels (left and right channel). The float value returned ranges from 0.0 to

1.0, the lowest and highest level possible, respectively.
= Moreover, other available data is frequency values. They are stored in the arrays SOUND DATA LEFT and
SOUND _DATA_RI GHT, which are both of the data type int. There are up to 511 values and each describes the

volume of a »

= The length-operator of the » tells how much valid data they contain. A check may be necessary and then
just take the values that are actually available/provided to have a proper effect. But it is secure to always

assume 511 values.

= In contrast to other dynamic arrays, in MADRIX Script those arrays will not grow because their size is fixed.

Trying to get an invalid element, always results in 0.

The First S2L Example

The following example for the MAS Script Effect analyses the left and the right audio channel. Lines will be drawn onto

the matrix to indicate the average frequency.

const color LEFT_CHANNEL = {255, 0, 0, 128};
const col or R GHT_CHANNEL= {0, 255, 0, 128};

void InitEffect()

{
}
float avgFrequ(float array[])
{
float result;
//to avoid division by zero later on
if(array.length > 0)
{
for(int i =0; i < array.length; i++)
result += array[i];
result /= (float)array.|ength;
}
return(result);
}

voi d RenderEffect ()

www.madrix.com /1125



MADRIX 3 Script Help and Manual Version 2.15. [Part B] MADRIX Script (Introduction)

int valL = (int)(GetSoundLevel (0)*255.0);
int valR = (int)(GetSoundLevel (1)*255.0);
color ¢ = {valL, valR (valL * valR) %255, (valR + vallL) / 2, 0};

float i HL = (fl oat)avgFrequ( SOUND_DATA LEFT);
float i HR = (fl oat)avgFrequ( SOUND _DATA RI GHT);

Cear();

DrawectorLine(c, 0.0, iH,, 1.0, iHL);
DrawectorLine(c, iHL, 0.0, iHL, 1.0);

L0-i HL);

Dr awVect or Li ne(c, 0.0, 1
1.0 iHL, 1.0);

iHL, 1.0,
Dr awVect or Li ne( c, 1. O-

DrawectorLine(c, 0.0, iHR 1.0, iHR);
DrawectorLine(c, iHR 0.0, iHR 1.0);

DrawectorLine(c, 0.0, 1.0-iHR 1.0, 1.0-iHR);
DrawectorLine(c, 1.0-iHR 0.0, 1.0-iHR 1.0);

2.2,.2.2 Music2lLight (M2L)

Introduction

Music2Light effects can go a step further and analyze music regarding music theoretical aspects. Tonality, scale, or
intervals are only some examples of the data that can be retrieved by the sound analysis. This chapter describes how

to retrieve the data provided by MADRIX. However, it does not describe any music theory.

Using Tonality And Scale

Let us start with tonality and scale of a chord. The two can be retrieved via the functions GetTonality() and
GetToneScale(), respectively. The exemplary sample source code for the MAS Script Effect below uses tonality and
scale to select a color and the alpha value will be the background color. Please remember: an audio input signal is

needed.

const color g _colorTable[] ={

{255, 0, 0, O}, /1C
{255, 128, 128, 128}, //C#
{0, 255, 0, 0}, /1D
{128, 255,128, 128}, /| D¢
{0, 0, 2550}, =
{255, 255, 0, O}, IIF

{255, 255, 128, 128}, [//F#
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{255, 0, 255, 0},
{255, 128, 255, 128},
{255, 128, 0, O},
{255, 100, 100, 100},
{255, 255, 255, 128

if (idx>=0 && idx<=11) C earCol or(g_col orTabl e[i dx]);

b
void InitEffect()
{
}
voi d Render Effect ()
{
int idx=CGetTonality();
el se d ear Col or ( BLACK) ;
int alpha = (255 / (1 + GetToneScale()));
Cl ear Al pha(al pha);
}
Explanation:

111G
I1G#
1A
Il A#
/1B

= The first thing is to create a color table in which each entry equals a tonality. If the tonality is undetermined, the

function GetTonality() results in -1.

» Therefore, we have to check if the value is a valid array index and eventually draw a black matrix. You could use

the function IsTonality() to check if the tonality was set or not.

Using Notes

MADRIX is able to identify the notes played in a song. The lowest note that can be evaluated is the C with 8.25 Hz.

The highest note is an G with 12.6 kHz. There are two functions available to get information about the identified notes.

GetNoteValue() retrieves the volume of the given note and IsNote() returns TRUE if the given note has been detected,

otherwise FALSE. There is the function GetAllNoteValues(), which fills an array with the volume of each note. Using

this method for a lot of notes is much faster then calling GetNoteValue(). An overview over which index corresponds to

which note is given by the »

The next example for the MAS Script Effect uses played notes to fill the matrix with different colors. It uses only the

values of three frequencies of C.

void InitEffect()

{
}

voi d RenderEffect ()
{

float val[];
[/C with 528Hz

val [0] = (float) Get NoteVal ue(72) / 127.0;
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/1 C with 1056KHz
val[1] = (float) Get NoteVal ue(84) / 127.0;
[/ICwith 2112KHz
val [2] = (float) Get NoteVal ue(96) / 127.0;

color c;
c.r = (int)(255.0 * val[0]);

c.g ; (int)(255.0 * val[1]);
c.b = (int)(255.0 * val[2]);
Clear(c);
}
Explanation:

= First, the levels of the notes are retrieved and normalized to the range of 0.0 to 1.0. Hereby, only three C notes

are used.

» Then, a color is initialized and the matrix is filled.

Using Intervals

There are similar functions to get information about the intervals indexed from 0 (small second interval) to 10 (large
seventh interval). The function IsInterval() returns TRUE if the specified interval could be analyzed, otherwise FALSE.
Again, the function GetAllIntervals() fills an array rapidly, each element with either TRUE (interval was analyzed) or
FALSE (interval was not analyzed). The following short example for the MAS Script Effect clarifies the usage of
GetAllIntervals():

const int mddl e=CGet Matri xHei ght ()/2;

int buf[];
int xStep;
void InitEffect()
{
Get Al I I nterval s(buf);
xSt ep=max(CGet Matri xWdt h()/buf.length, 1);
}
voi d Render Ef f ect ()
{
Cl ear Al pha(255);
Cet Al I I nterval s(buf);
for (int i=0;i<buf.length;i++)
{
DrawPi xel Li ne(WH TE, i *xStep, 'buf[i]*mi ddl e, i *xStep, (1+!' buf[i])*m ddl e);
}
}
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Explanation:

» At first, in InitEffect() the buffer bufis filled once, just in order to get the buffer length. With the buffer length, a
horizontal distance xStep is calculated to separate some lines equally later on. Using the function max(), the

distance is at least 1.

» Calling RenderEffect() the buffer bufis filled with the current interval appearances. Then, a vertical line is drawn
for every interval, either from the middle to the top of the matrix (if the interval was analyzed) or from middle to
bottom (if not).

Using Other Tone Theoretical Parameters

There is lots of other data which may be used to create effects, e.g. the sound level or the note of the currently

lowest note (bass tone). The handling is similar to the functions described above. Further details are given in the »
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3 MADRIX Script (Programming Language
Overview)

3.1 Keyword Search

The following keywords are available in MADRIX Script:

>
>
>
>
>
>
>
[ >4
>
>
>

>

3.2 List Of Functions (Alphabetical Order)

Overview

In addition to the specific functions of the MAS Script Effect, Macros for effects, the Main Ouput Macro, and the
Storage Place Macro ( ), the following table lists additional functions. The "+" symbol indicates, in which

areas of MADRIX Script the functions can be used.

Function Description Mas | faacro | Storag | Main
Script | Effect | Place %L:g‘rg
s Macro
float abs(float x) Returns the absolute value of x. + + + +
void AddPixelTransposeEntry Adds one entry to the pixel transpose table and resizes the | + + + +
(int srcX, int srcY, int destX, int table if necessary. srcX and srcY are the coordinates in X
destY) and Y of the source. destX and destY are the destination

coordinates. »
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void AddPixelTransposeEntry3D | Adds one entry to the pixel transpose table and resizes the +
(int srcX, int srcY, int srcZ, int table if necessary. srcX, srcY, and srcZ are the coordinates
destX, int destY, int destz) in X, Y, and Z of the source. destX, destY, and destZ are
the coordinates of the destination. »
float arccos(float a) Returns the arc cosine of the angle ain radian measure or +
float arccosDeg(float a) degrees, respectively.
float arccot(float a) Returns the arc cotangent of the angle ain radian measure +
float arccotDeg(float a) or degrees, respectively.
float arcsin(float a) Returns the arc sine of the angle ain radian measure or +
float arcsinDeg(float a) degrees, respectively.
float arctan(float a) Returns the arc tangent of the angle ain radian measure +
float arctanDeg(float a) or degrees, respectively
float arctan2(float x, float y) Returns the angle of polar coordinates from two Cartesian +
coordinates x and y.
float ceil(float f) Rounds up the given value to the next integer value. E.g. +
ceil(2.00001) = 3.0
void ChangeBrightness(color col) | Adds the values of the specified color to the current color +
of each pixel in the matrix. »
int CheckScriptEngineVersion Checks the Script engine version in use and returns 1 if the +
(int major, int minor) version is equal or higher to the version specified with
majorand minor. Or else 0 is returned. The current Script
Engine Version is 2.15. A useful function to check if the
minimum requirements of your script are met. »
int CheckSoftwareVersion(int Checks the MADRIX software version in use and returns 1 if +
major, int minor, int subminor, int | the version is equal or higher to the version specified with
subsubminor) major, minor, subminor, and subsubminor. Or else 0 is
returned. The current MADRIX version is 3.5.1.0. You can
check which version you are using by opening the Lodfile in
MADRIX (at the beginning of the file) or check the
MADRIX.exe (perform a right-click > Properties > Version).
A useful function to check if the minimum requirements of
your script are met. »
void Clear() Fills the whole matrix with the given color. The default +
void Clear(color col) color (no color parameter) is black.
void ClearAlpha(int alpha) Sets the alpha value of each pixel in the matrix to alpha. +
void ClearColor(color col) Fills the whole matrix with the given color without +
changing the alpha value.
void ColorReplace(color oldCol, Replaces the given color oldCo/with a new one (newCol). +
color newCol)
float cotan(float a) Returns the cotangent of the angle ain radian measure or +
float cotanDeg(float a) degrees, respectively.
float cos(float a) Returns the cosine of the angle ain radian measure or +
float cosDeg(float a) degrees, respectively.
float cosH(float a) Returns the hyperbolic cosine of the angle ain radian +
float cosHDeg(float a) measure or degrees, respectively.
void CreatePixelTransposeTable | Creates the pixel transpose table with the given size and +
(int size, int growsize) growsize. »
float deg2rad(float a) Converts the angle a from degrees to radian measure. +
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void Dim(float value) Reduces the brightness of the complete virtual matrix. +
Valid values for value range from 0.0 to 1.0.
void DimPixel(float value, int x, int | Reduces the brightness of an individual pixel. x and y are +
y) the coordinates of the pixel. Valid values for value range
from 0.0 to 1.0.
void DimPixel3D(float value, int x, | Reduces the brightness of an individual voxel. x, y, and z +
int y, int z) are the coordinates of the voxel. Valid values for value
range from 0.0 to 1.0.
void DimPixelArea(float value, int | Reduces the brightness of a certain area of the virtual +
X, int y, int width, int height) matrix. x and y are the coordinates of the area (upper left
corner). width and height specify the width and height of
the area. Valid values for value range from 0.0 to 1.0.
void DimPixelArea3D(float value, | Reduces the brightness of a certain area of the virtual 3D +
int x, int y, int z, int width, int matrix. x, y, and z are the coordinates of the area (front
height, int depth) upper left corner). width, height, and depth specify the
width, height, and depth of the area. Valid values for value
range from 0.0 to 1.0.
void DrawPixelArea(color matrix[] | Copies data from a 2-dimensional array of colors and +
[1, int xDst, int yDst, int w, int h, | renders it on the matrix. »
int xSrc, int ySrc, color fiter)
void DrawPixelArea3D(color Copies data from a 3-dimensional array of colors and +
matrix[][][], int xDst, int yDst, int [ renders it on the matrix.
zDst, int w, int h, int d,
int xSrc, int ySrc, int zSrc, color
fitter)
void DrawPixelLine(color col, int | Draws a line from pixel (x1, y1) to pixel (x2, y2) with the +
x1, int y1, int x2, int y2) specified color col
void DrawPixelLine3D(color col, | Draws a line from voxel (x1, y1, z1) to voxel (x2, y2, z2) +
int x1, int y1, int z1, int x2, int y2, | with the specified color col
int z2)
void DrawPixelShape(color col, Draws a given shape onto the matrix with the given size +
int shape, int x, int y, int z, int w, | (width w, height h, depth d) at the given position (x, y, 2)
int h, int d, int lineWidth, int with the specified color col Learn more »
drawMode, int lookAtType)
void DrawPixelText(color ¢, font | Draws a text across the main output. » and »
f, string t, int X, int y, int rotation) | are structures. Valid values for rotation are
ROTATI ON_